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copyright
© 2010 Samsung Electronics Co., Ltd. All rights reserved.
This user’s guide is provided for information purposes only. All information included herein is subject to change without notice.
Samsung Electronics is not responsible for any direct or indirect damages, arising from or related to use of this user’s guide.

• Samsung and Samsung logo are trademarks of Electronics Co., Ltd.
• PCL and PCL 6 are trademarks of Hewlett-Packard Company.
• Microsoft, Internet Explore, Windows, Windows Vista, Windows 7 and Windows 2008 Server R2 either registered trademarks or trademarks of Microsoft 

Corporation.
• PostScript 3 is a trademark of Adobe System, Inc.
• UFST® and MicroType™ are registered trademarks of Monotype Imaging Inc.
• TrueType, Mac and Mac OS are trademarks of Apple Inc., registered in the U.S and other countries.
• LaserWriter is a trademark of Apple Inc.
• All other brand or product names are trademarks of their respective companies or organizations.

Refer to the 'LICENSE.txt' file in the provided CD-ROM for the open source license information.

REV. 1.04
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safety information
These warnings and precautions are included to prevent injury to you and others, and to prevent any potential damage to 
your machine. Be sure to read and understand all of these instructions before using the machine.
Use common sense for operating any electrical appliance and whenever using your machine. Also, follow all warnings and 
instructions marked on the machine and in the accompanying literature. After reading this section, keep it in a safe place 
for future reference.

IMPORTANT SAFETY SYMBOLS

This section explains the meanings of all icons and signs in the user's guide. These safety symbols are in order, according to the degree of 
danger.

Explanation of all icons and signs used in the user’s guide:

Warning Hazards or unsafe practices that may result in severe personal injury or death.

Caution Hazards or unsafe practices that may result in minor personal injury or property damage.

Do not attempt.

Do not disassemble.

Do not touch.

Unplug the power cord from the wall socket.

Make sure the machine is grounded to prevent electric shock.

Call the service center for help.

Follow directions explicitly.

OPERATING ENVIRONMENT

 Warning

Do not use if the power cord is damaged or if the 
electrical outlet is not grounded.

This could result in electric shock or fire. 

Do not bend, or place heavy objects on the power 
cord. 

Stepping on or allowing the power cord to be 
crushed by a heavy object could result in electric 
shock or fire. 

Do not place anything on top of the machine (water, 
small metal or heavy objects, candles, lit cigarettes, 
etc.).

This could result in electric shock or fire. 

Do not remove the plug by pulling on the cord; do not 
handle the plug with wet hands. 

This could result in electric shock or fire. 
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 Caution

During an electrical storm or for a period of 
non-operation, remove the power plug from the 
electrical outlet. 

This could result in electric shock or fire. 

If the plug does not easily enter the electrical outlet, do not 
attempt to force it in. 

Call an electrician to change the electrical outlet, or this 
could result in electric shock.

Be careful, the paper output area is hot. 
Burns could occur. 

Do not allow pets to chew on the AC power, telephone or PC 
interface cords.

This could result in electric shock or fire and/or injury to your 
pet. 

If the machine has been dropped, or if the cabinet appears 
damaged, unplug the machine from all interface connections 
and request assistance from qualified service personnel.

Otherwise, this could result in electric shock or fire.

If the machine does not operate properly after these 
instructions have been followed, unplug the machine from all 
interface connections and request assistance from qualified 
service personnel.

Otherwise, this could result in electric shock or fire.

If the machine exhibits a sudden and distinct change in 
performance, unplug the machine from all interface 
connections and request assistance from qualified service 
personnel.

Otherwise, this could result in electric shock or fire.

OPERATING METHOD

 Caution

Do not forcefully pull the paper out during printing. 
It can cause damage to the machine.

When printing large quantities, the bottom part of the 
paper output area may get hot. Do not allow children 
to touch. 

Burns can occur.

Be careful not to put your hand between the machine 
and paper tray.

You may get injured.

When removing jammed paper, do not use tweezers 
or sharp metal objects. 

It can damage the machine.

Do not block or push objects into the ventilation opening.
This could result in elevated component temperatures which 

can cause damage or fire.

Do not allow too many papers to stack up in the paper output 
tray.

It can damage the machine. 

Be care when replacing paper or removing jammed paper. 
New paper has sharp edges and can cause painful cuts.

This machine's power interception device is the power cord. 
To switch off the power supply, remove the power cord from 

the electrical outlet. 

If the machine gets overheated, it releases smoke, 
makes strange noises, or generates an odd odor, 
immediately turn off the power switch and unplug the 
machine.

This could result in electric shock or fire. 
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INSTALLATION / MOVING

 Warning

Do not place the machine in an area with dust, 
humidity or water leaks. 

This could result in electric shock or fire. 

 Caution

Before moving the machine, turn the power off and 
disconnect all cords.
Then lift the machine:
• If the machine weighs under 20 kg (44.09lb), lift with 
1 person.
• If the machine weighs 20 kg (44.09lb) - 40kg 
(88.18lb), lift with 2 people.
• If the machine weighs more than 40 kg (88.18lb), lift 
with 4 or more people.

The machine could fall, causing injury or machine damage.

Do not put a cover over the machine or place it in an airtight 
location, such as a closet.

If the machine is not well-ventilated, this could result in fire.

Do not place the machine on an unstable surface.
The machine could fall, causing injury or machine damage.

Make sure you plug the power cord into a grounded electrical 
outlet.

Otherwise, this could result in electric shock or fire.

The machine should be connected to 
the power level which is specified on the label.

If you are unsure and want to check the power level you are 
using, contact the electrical utility company.

Do not overload wall outlets and extension cords.
This can diminish performance, and could result in electric 

shock or fire.

Use only No.26 AWGa

a.  AWG: American Wire Gauge

 or larger, telephone line cord, if 
necessary.

Otherwise, it can cause damage to the machine.

Use the power cord supplied with your machine for safe 
operation. If you are using a cord which is longer than 2 meters 
(6 feet) with a 140V machine, then the gauge should be 16 
AWG or larger.

 Otherwise, it can cause damage to the machine, and could 
result in electric shock or fire.

MAINTENANCE / CHECKING

 Caution

Unplug this product from the wall outlet before 
cleaning the inside of the machine. Do not clean the 
machine with benzene, paint thinner or alcohol; do 
not spray water directly into the machine. 

This could result in electric shock or fire. 

Keep cleaning supplies away from children. 
Children could get hurt.
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SUPPLY USAGE

 Caution

Do not disassemble the toner cartridge.
Toner dust can be dangerous if inhaled or 

ingested.

When storing supplies such as toner cartridges, keep 
them away from children.

Toner dust can be dangerous if inhaled or 
ingested.

Do not burn any of the supplies such as toner 
cartridge or fuser unit.

This could cause an explosion or uncontrollable 
fire.

Using recycled supplies, such as toner, can cause damage to 
the machine.

In case of damage due to the use of recycled supplies, a 
service fee will be charged.

When changing the toner cartridge or removing jammed paper, 
be careful not to let toner dust touch your body or clothes.

Toner dust can be dangerous if inhaled or ingested.

When toner gets on your clothing, do not use hot water to wash 
it.

Hot water sets toner into fabric. Use cold water. 

When you are working inside the machine replacing 
supplies or cleaning the inside, do not operate the 
machine.

You could get injured.

Do not disassemble, repair or rebuild the machine by 
yourself. 

It can damage the machine. Call a certified 
technician when the machine needs repair.

Keep the power cable and the contact surface of the plug clean 
from dust or water.

Otherwise, this could result in electric shock or fire. 

To clean and operate the machine, strictly follow the user's 
guide provided with the machine.

Otherwise, you could damage the machine.

Do not remove any covers or guards that are fastened with 
screws.

The machine should only be repaired by a Samsung service 
technician.
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regulatory information
This machine is designed for a normal work environment and certified with several regulatory statements.

LASER SAFETY STATEMENT

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and 
elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1.
Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to 
laser radiation above a Class I level during normal operation, user maintenance or prescribed service condition.
• Wavelength: 800 nm
• Beam divergence

- Paraller: 11 degrees
- Perpendicular: 35 degrees

• Maximum power of energy output: 12 mW

WARNING
Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible, 
can damage your eyes.
When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:

OZONE SAFETY

During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is 
advisable that the machine be operated in a well ventilated area.
If you need additional information about ozone, contact your local Samsung dealer.
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POWER SAVE

This printer contains advanced energy conservation technology that reduces power consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power consumption is automatically lowered. 
ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 
For more information on the ENERGY STAR program see http://www.energystar.gov.

RECYCLING

Recycle or dispose of the packaging material for this product in an environmentally responsible manner.

CHINA ONLY

CORRECT DISPOSAL OF THIS PRODUCT (WASTE ELECTRICAL & ELECTRONIC EQUIPMENT)

(Applicable in the European Union and other European countries with separate collection systems)
This marking shown on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, 
USB cable) should not be disposed of with other household wastes at the end of its working life. To prevent possible harm to the environment 
or human health from uncontrolled waste disposal, separate this from other types of wastes and recycle it responsibly to promote the 
sustainable reuse of material resources. 
Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and 
how they can take this item for environmentally safe recycling. 
Business users should contact their supplier and check the terms and conditions of the purchase contract. This product should not be mixed 
with other commercial wastes for disposal.

RADIO FREQUENCY EMISSIONS

FCC Information to the User
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that may cause undesired operation.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures:
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• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or experienced radio TV technician for help.

Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to
operate the equipment.

Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.
Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe B prescrites dans la 
norme sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.

RUSSIA ONLY

YALNIZCA TÜRKIYE

GERMANY ONLY

REPLACING THE FITTED PLUG (FOR UK ONLY)

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the 
fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until 
you have another fuse cover. 
Contact the people from you purchased the machine.
The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have normal 
13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.
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Important warning: 
You must earth this machine.
The wires in the mains lead have the following color code:
• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live

If the wires in the mains lead do not match the colors marked in your plug, do the following:
You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety ‘Earth symbol’ or colored green and yellow or 
green.
You must connect the blue wire to the pin which is marked with the letter “N” or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

DECLARATION OF CONFORMITY (EUROPEAN COUNTRIES)

Approvals and Certifications
The CE marking applied to this product symbolizes Samsung Electronics Co., Ltd. Declaration of Conformity with the following applicable 
93/68/EEC Directives of the European Union as of the dates indicated:

ML-1865W : R&TTE Directive (1999/5/EC)
The declaration of conformity may be consulted at www.samsung.com/printer, go to Support > Download center and enter your printer (MFP) 
name to browse the EuDoC. 
January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of the member states related to low voltage equipment.
January 1, 1996: Council Directive 2004/108/EC (92/31/EEC), approximation of the laws of the Member States related to electromagnetic 
compatibility.
March 9, 1999: Council Directive 1999/5/EC on radio equipment and telecommunications terminal equipment and the mutual recognition of 
their conformity. A full declaration, defining the relevant Directives and referenced standards can be obtained from your Samsung Electronics 
Co., Ltd. representative.

European Radio Approval Information (for products fitted with EU-approved radio devices)
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz band, may be 
present (embedded) in your printer system which is intended for home or office use. This section is only applicable if these devices are present. 
Refer to the system label to verify the presence of wireless devices.
Wireless devices that may be in your system are only qualified for use in the European Union or associated areas if a CE mark 
with  a Notified Body Registration Number and the Alert Symbol is on the system label.
The power output of the wireless device or devices that may be embedded in you printer is well below the RF exposure limits as set by the 
European Commission through the R&TTE directive.

European States qualified under wireless approvals:
EU
Austria, Belgium, Cyprus, Czech Republic, Denmark, Estonia, Finland, France (with frequency restrictions), Germany, Greece, Hungary, 
Ireland, Italy, Latvia, Lithuania, Luxembourg, Malta, The Netherlands, Poland, Portugal, Slovakia, Slovenia, Spain, Sweden and the U.K.
EEA/EFTA countries
Iceland, Liechtenstein, Norway and Switzerland

European States with restrictions on use:
EU
In France, the frequency range is restricted to 2446.5-2483.5 MHz for devices above 10 mW transmitting power such as wireless
EEA/EFTA countries
No limitations at this time
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REGULATORY COMPLIANCE STATEMENTS

Wireless Guidance
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be 
present (embedded) in your printer system. The following section is a general overview of considerations while operating a wireless device.
Additional limitations, cautions, and concerns for specific countries are listed in the specific country sections (or country group sections). The 
wireless devices in your system are only qualified for use in the countries identified by the Radio Approval Marks on the system rating label. If 
the country you will be using the wireless device in, is not listed, contact your local Radio Approval agency for requirements. Wireless devices 
are closely regulated and use may not be allowed.
The power output of the wireless device or devices that may be embedded in your printer is well below the RF exposure limits as known at this 
time. Because the wireless devices (which may be embedded into your printer) emit less energy than is allowed in radio frequency safety 
standards and recommendations, manufacturer believes these devices are safe for use. Regardless of the power levels, care should be taken 
to minimize human contact during normal operation.
As a general guideline, a separation of 20 cm (8 inches) between the wireless device and the body, for use of a wireless device near the body 
(this does not include extremities) is typical. This device should be used more than 20 cm (8 inches) from the body when wireless devices are 
on and transmitting.
This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.
Some circumstances require restrictions on wireless devices. Examples of common restrictions are listed below:

Radio frequency wireless communication can interfere with equipment on commercial aircraft. Current aviation regulations require wireless 
devices to be turned off while traveling in an airplane. IEEE 802.11 (also known as wireless Ethernet) and Bluetooth communication devices 
are examples of devices that provide wireless communication.
In environments where the risk of interference to other devices or services is harmful or perceived as harmful, the option to use a wireless 
device may be restricted or eliminated. Airports, Hospitals, and Oxygen or flammable gas laden atmospheres are limited examples where use 
of wireless devices may be restricted or eliminated. When in environments where you are uncertain of the sanction to use wireless devices, 
ask the applicable authority for authorization prior to use or turning on the wireless device.
Every country has different restrictions on the use of wireless devices. Since your system is equipped with a wireless device, when traveling 
between countries with your system, check with the local Radio Approval authorities prior to any move or trip for any restrictions on the use of 
a wireless device in the destination country.
If your system came equipped with an internal embedded wireless device, do not operate the wireless device unless all covers and shields are 
in place and the system is fully assembled.

Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to use it. 
Contact manufacturer for service.

Only use drivers approved for the country in which the device will be used. See the manufacturer System Restoration Kit, or contact
manufacturer Technical Support for additional information.

OPENSSL LICENSE

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes 

software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)".
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without 

Prior written permission. For written permission, please contact openssl-core@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written 

permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the 

OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)".
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
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SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim 
Hudson (tjh@cryptsoft.com).

ORIGINAL SSLEAY LICENSE

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with 
Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are adhered to. The following conditions apply to 
all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this 
distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's, 
and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given 
attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation 
(online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes 

cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the routines from the library 
being used are not cryptographic related.

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an
acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)".

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, 
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publicly available version or derivative of this code cannot be changed. i.e. this code cannot simply 
be copied and put under another distribution licence [including the GNU Public Licence.
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CHINA ONLY
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about this user’s guide
This user’s guide provides information about basic understanding of the machine as well as detailed explanation on each 
step during actual usage. It is a valuable resource for both novice and professional users for the proper installation and 
use of the machine.

•Read the safety information before using the machine.
•If you have a problem using the machine, refer to the troubleshooting chapter. (See "Troubleshooting" on page 57.)
•Terms used in this user’s guide are explained in the glossary chapter. (See "Glossary" on page 73.)
•Illustrations in this user’s guide may differ from your machine depending on its options or models.
•The procedures in this user’s guide are mainly based on Windows XP.

CONVENTION
Some terms in this guide are used interchangeably, as below:
• Document is synonymous with original.
• Paper is synonymous with media, or print media.
• Machine refers to printer or MFP.
The following table offers the conventions of this guide:

CONVENTION DESCRIPTION EXAMPLE

Bold For texts on the display or button names on the machine. Cancel

Note Provides additional information or details for the machine function and feature. The date format may differ from country 
to country.

Caution Contains information you can use to protect the machine from possible 
mechanical damage or malfunction.

Do not touch the surface of the drum 
located in the toner cartridge or imaging 
unit.

Footnote Provides additional information on certain words or a phrases. a. pages per minute

(“Cross-reference”) Refers you to additional detailed information. (See "Finding more information" on 
page 15.)
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FINDING MORE INFORMATION
You can find information about setting up and using your machine in the following resources, either as a print-out or on screen.

MATERIAL NAME DESCRIPTION

Quick Install Guide This guide provides information on setting up your machine. This guide is provided in the box with the printer.

User’s Guide This guide provides you with step-by-step instructions for using your machine’s full features, maintaining your machine, 
troubleshooting, and replacing supplies. 

Machine Driver Help This help provides you with information about the printer driver and instructions for setting up the options for printing. (See "Using help" 
on page 44.)

Samsung website If you have Internet access, you can get help, support, machine drivers, manuals, and order information from the Samsung website,
www.samsung.com/printer.

Downloadable 
software

You can download useful software programs from the Samsung website. 
• Samsung AnyWeb Print: helps personal users to screen-capture the website screen in Windows Internet Explorer easily. 

(http://solution.samsungprinter.com/personal/anywebprint)



Features of your new product_ 16

features of your new product
Your new machine is equipped with a number of special features that improve the quality of the documents you print.

SPECIAL FEATURES

Print with excellent quality and speed

• You can print with a resolution of up to 1,200 x 1200 dpi 
effective output.

• Your machine prints A4-sized paper at up to 18 ppm and 
letter-sized paper at up to 19 ppm.

Handle many different types of printable material

• The 150-sheet tray supports plain paper in various sizes.

Create professional documents

• Print Watermarks. You can customize your documents with 
words, such as “Confidential”. (See "Using watermarks" on 
page 46.)

• Print Posters. The text and pictures of each page of your 
document are magnified and printed across the sheet of 
paper and can then be taped together to form a poster. (See 
"Printing posters" on page 45.)

• You can use preprinted forms and letterhead with plain 
paper. (See "Using overlays" on page 46.)

Save time and money

• To save paper, you can print multiple pages on one single 
sheet of paper. (See "Printing multiple pages on one sheet of 
paper" on page 45.)

• This machine automatically conserves electricity by 
substantially reducing power consumption when not in use.

• To save paper, you can print on both sides of the paper 
(Manual). (See "Printing on both sides of the paper (Manual)" 
on page 45.)

Print in various environments

• You can print with Windows as well as Linux and Macintosh 
OS systems.

• Your machine is equipped with a USB interface.

DLNA 

This Machine supports DLNA Printing as a DMPr (Digital Media 
Printer). You can easily print by the DLNA Device including 
Printing Control Capability on the home network. 
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FEATURES BY MODELS
The machine is designed to support all of your document needs from printing to more advanced networking solutions for your business.
Features by models include:

FEATURES ML-1865W SERIES

High Speed USB 2.0

Duplex (2-sided) printing (Manual)

Network Interface 802.11 b/g/n wireless LAN1

1.Depending on your country, wireless LAN cards may not be available. Contact 
your local Samsung dealer or the retailer where you bought your printer.

( : Included) 
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1.introduction
This chapter gives you an overview of your machine:
This chapter includes:
• Machine overview
• Control panel overview
• Understanding the status LED

MACHINE OVERVIEW
Front view

This illustration may differ from your machine depending on its model.

1 Control panel 6 Paper width guides

2 Top cover 7 Output support

3 Toner cartridge 8 Output tray (face down)

4 Tray

5 Paper length guide
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Rear view

This illustration may differ from your machine depending on its model.

1 USB port

2 Power cord receptacle
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CONTROL PANEL OVERVIEW
This control panel may differ from your machine depending on the model.

1
Jam & Online/Error Shows the status of paper jams in your machine and the status of your machine. (See "Understanding the status LED" on 

page 21.)

2 Wireless Shows the status of wireless network. When the LED on, the machine is ready. (See "Wireless LED" on page 21.)

3
WPS If your wireless access point supports WPS (Wi-Fi Protected Setup™), you can configure the wireless network connection 

easily without a computer. (See "Setting a wireless network with the WPS button" on page 29.)

4 Power You can turn the power on and off with this button. (See "(Power) button" on page 21.)
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UNDERSTANDING THE STATUS LED

Status LEDs 
The color of the LEDs indicates the machine's current status.

STATUS LED DESCRIPTION

Off • The machine is off-line.
• The machine is in sleep mode.

Green On • The machine is in ready mode or warming up.

Blinking • When the LED blinks, the machine is receiving 
data from the computer or printing documents.

• When the LED blinks rapidly, the machine is 
operating special functions.

Red On • The cover is opened. Close the cover 
completely.

• There is no paper in the tray. Load paper in the 
tray.

• The machine has stopped due to a major error.
• Your system has some problems. If this 

problem occurs, contact a service 
representative.

• A toner cartridge has almost reached its 
estimated cartridge lifea

a.Estimated cartridge life means the expected or estimated toner 
cartridge life, which indicates the average capacity of print-outs and is 
designed pursuant to ISO/IEC 19752. The number of pages may be 
affected by operating environment, percentage of image area, printing 
interval, media type, and media size. Some amount of toner may 
remain in the cartridge even when red LED is on and the printer stops 
printing.

. It is recommended to 
replace the toner cartridge (See "Replacing the 
toner cartridge" on page 66).

Blinking • When the LED blinks slowly, a small amount of 
toner is left in the cartridge. The estimated 
cartridge lifea of toner is close. Prepare a new 
cartridge for replacement. You may temporarily 
increase the printing quality by redistributing the 
toner (See "Redistributing toner" on page 57).

• The machine is printing in manual feed mode or 
in manual duplex mode. 

Orange On • A paper jam has occurred (See "Clearing paper 
jams" on page 57).

Blinking • Upgrading Firmware. Please wait.

Samsung does not recommend using a non-genuine Samsung toner 
cartridge such as one that is refilled or remanufactured. Samsung 
cannot guarantee a non-genuine Samsung toner cartridge's quality. 
Service or repair required as a result of using non-genuine Samsung 
toner cartridges will not be covered under the machine warranty. 

All printing errors will appear in the Smart Panel program window. If 
the problem persists, contact a service representative.

Wireless LED 

WIRELESS LED STATUS DESCRIPTION

Blue Off ( ) Wireless network is disconnected.

On ( ) Wireless network is connected

Slowly blinks 
( )

The machine starts connecting to a 
wireless network.

Quickly blinks 
( )

• The machine is connecting to 
access point (or wireless router).

• Wireless network connection is 
being disconnected.

INTRODUCING THE USEFUL BUTTONS

(WPS) button
This feature automatically detects which WPS (Wi-Fi Protected Setup™) 
mode your access point uses. By pushing a button on the wireless LAN 
router / access point and the machine, you can setup the wireless network 
and security settings See "Setting a wireless network with the WPS button" 
on page 29).

FUNCTION DESCRIPTION

To print a demo page
In the ready mode, press and hold for
about 10 seconds until the green LED blinks 
slowly, and release.

To print a machine 
report In the ready mode, press and hold for

about 15 seconds and release.

To print on a special 
paper Print one sheet at a time using the . (See 

"Manual feeding in the tray" on page 41.)

To use the duplex 
feature Print one sheet at a time using the . (See 

"Printing on both sides of the paper (Manual)" 
on page 48.)

(Power) button
By pressing the , you can:

FUNCTION DESCRIPTION

Power On/Off Press this button to turn the power on or off. 

Cancel print job During printing, press this button once. The 
print job is cleared from both the machine and 
the computer and then the machine returns to 
the ready mode. This may take some time 
depending on the size of the print job.

If you press this button for more than 3 
seconds, the power goes off. 
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Turning on the machine
1. Plug in the power cord.

2. Press  on the control panel.

If you want to turn the power off, press and hold this button for 
about 3 seconds.
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2.getting started
This chapter gives you step-by-step instructions for setting up the USB connected machine and software.
This chapter includes:
• Setting up the hardware
• Supplied software

• System requirements
• Installing USB connected machine’s driver

SETTING UP THE HARDWARE
This section shows the steps to set up the hardware, as is explained in the 
Quick Install Guide. Make sure you read the Quick Install Guide first and 
follow the steps below:

Location
1. Select a stable location.

Select a level, stable place with adequate space for air circulation. Allow 
extra space for opening cover(s) and tray(s). 
The area should be well ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to the 
edge of your desk or table.

Printing is suitable for altitudes under 1,000 m (3,281 ft). 
Place the machine on a flat, stable surface so that there is no incline 
greater than 2 mm (0.08 inch). Otherwise, printing quality may be 
affected.

2. Unpack the machine and check all the enclosed items.
3. Remove tape holding the machine securely.
4. Install the toner cartridge.
5. Load paper. (See "Loading paper in the tray" on page 39.)
6. Make sure that all cables are connected to the machine. 
7. Turn the machine on. (See "Turning on the machine" on page 22.)

This machine will not operate when the power main fails.

SUPPLIED SOFTWARE
After you have set up your machine and connected it to your computer, you 
must install the printer software. If you are a Windows or Macintosh OS 
user, install the software from the supplied CD and if you are a Linux OS 
user, download the software from the Samsung website 
(www.samsung.com/printer) and install.

Machine software is occasionally updated for reasons like the release 
of new operating system and etc. If needed, download the latest 
version from the Samsung website (www.samsung.com/printer).

OS CONTENTS

Windows • Printer driver: Use this driver to take full advantage of 
your machine’s features.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• Printer Settings Utility: This program allows you to set up 
printer’s other options from your computer.

Macintosh • Printer Driver: Use this driver to take full advantage of 
your machine’s features.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• Printer Settings Utility: This program allows you to set up 
printer’s other options from your computer.

Linux • Unified Linux Driver: Use this driver to take full 
advantage of your machine’s features.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• Printer Settings Utility: This program allows you to set up 
printer’s other options from your computer.

SYSTEM REQUIREMENTS
Before you begin, ensure that your system meets the following 
requirements:

Windows
Your machine supports the following Windows operating systems.



OPERATING 
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM
FREE
HDD

SPACE

Windows® 
2000

Intel® Pentium® II 400 
MHz (Pentium III 933 
MHz)

64 MB 
(128 MB)

600 MB

Windows® XP Intel® Pentium® III 933 
MHz (Pentium IV 1 GHz)

128 MB 
(256 MB)

1.5 GB

Windows 
Server® 2003

Intel® Pentium® III 933 
MHz (Pentium IV 1 GHz)

128 MB 
(512 MB)

1.25 GB to 
2 GB

Windows 
Server® 2008

Intel® Pentium® IV 1 GHz 
(Pentium IV 2 GHz)

512 MB 
(2048 MB)

10 GB

Windows 
Vista®

Intel® Pentium® IV 3 GHz 512 MB 
(1024 MB)

15 GB

Windows® 7 Intel® Pentium® IV 1 GHz 
32-bit or 64-bit processor 
or higher

1 GB (2 
GB)

16 GB

• Support for DirectX® 9 graphics with 128 MB 
memory (to enable the Aero theme).

• DVD-R/W Drive

Windows 
Server® 2008 
R2

Intel® Pentium® IV 1 GHz 
(x86) or 1.4 GHz (x64) 
processors (2 GHz or 
faster)

512 MB 
(2048 MB)

10 GB
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•Internet Explorer 5.0 or higher is the minimum requirement for all 
Windows operating systems.

•Windows Terminal Services is compatible with this machine.

Macintosh

OPERATING
SYSTEM

REQUIREMENTS (RECOMMENDED)

CPU RAM
FREE
HDD 

SPACE

Mac OS X 
10.3 ~ 10.4

• Intel®
Processors

• PowerPC G4/ G5

• 128 MB for a 
PowerPC based 
Mac (512 MB)

• 512 MB for a 
Intel-based Mac 
(1 GB)

1 GB

Mac OS X 
10.5

• Intel®
Processors

• 867 MHz or 
faster Power PC 
G4/ G5

512 MB (1 GB) 1 GB

Mac OS X 
10.6

• Intel®
Processors

1 GB (2 GB) 1 GB

Linux

ITEM REQUIREMENTS

Operating 
system

RedHat Enterprise Linux WS 4, 5 (32/64bit)
Fedora 4, 5, 6, 7, 8, 9, 10, 11, 12 (32/64bit)
SuSE Linux 10.0, 10.1 (32bit)
OpenSuSE 10.2, 10.3, 11.0, 11.1, 11.2 (32/64bit)
Mandriva 2005, 2006, 2007, 2008, 2009, 2009.1 
(32/64bit) 
Ubuntu  5.04, 5.10, 6.06, 6.10, 7.04, 7.10, 8.04, 
8.10, 9.04, 9.10 (32/64bit)
SuSE Linux Enterprise Desktop 10, 11 (32/64bit)
Debian  4.0, 5.0 (32/64bit) 

CPU Pentium IV 2.4 GHz (Intel Core™2)

RAM 512 MB (1024 MB)

Free HDD space 1 GB (2 GB)

INSTALLING USB CONNECTED MACHINE’S 
DRIVER
A locally connected machine is a machine directly connected to your 
computer by a USB cable.

Only use a USB cable no longer then 3 m (10 ft.).

Windows
You can install the machine software using the typical or custom method.
The following steps are recommended for most users who use a machine 
directly connected to your computer. All components necessary for machine 
operations will be installed.
1. Make sure that the machine is connected to the computer and powered 

on.
If the “Found New Hardware Wizard” window appears during the 
installation procedure, click Cancel to close the window.

2. Insert the supplied software CD into your CD-ROM drive.
•The software CD should automatically run and an installation window 

will appear.
•If the installation window does not appear, click Start and then Run.

Type X:\Setup.exe, replacing “X” with the letter which represents 
your CD-ROM Drive. Click OK.

•If you use Windows Vista, Windows 7 and Windows 2008 Server R2 
click Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your CD-ROM Drive and click OK.

•If the AutoPlay window appears in Windows Vista, Windows 7 and 
Windows 2008 Server R2, click Run Setup.exe in Install or run 
program field, and click Continue or Yes in the User Account 
Control windows.
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3. Select Install now.

If necessary, select a language from the drop-down list.
The Advanced Installation has an option, Custom Installation.
The Custom Installation allows you to select the machine’s 
connection and choose individual component to install. Follow the 
instruction on the window.

4. Read the License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.
The software searches for the machine.

If your machine is not found in the network or locally, a window 
with below information appears.
• Check if you want to install the software without 

connecting the printer to the network or locally.
- Check this option to install the software without a machine 

connected. In this case, the print a test page window will be 
skipped.

• Search again
When you click this button, the firewall notice window appears;
- Turn off the firewall and Search again. For Window 

operating system, click Start > Control Panel > Windows 
Firewall, and inactivate this option. For other operating 
systems, refer to their guide.

- Turn off the firewall from the third party's program beside 
the operating system. Refer to the manual provided by 
individual programs.

• Direct Input
The Direct Input allows you to search for a specific machine 
on the newtwork.
- Search by IP address: Enter the IP address or the host 

name. Then click Next.
To verify your machine’s IP address, print a network 
configuration report (See "(WPS) button" on page 21).

- Search by network path: To find a shared machine (UNC 
Path), enter the shared name manually or find a shared 
printer by clicking the Browse button. Then click Next.

• Help
If your machine is not connected to the computer or network, 
This help button gives detailed information about the how to 
connect the machine.

5. The searched machines will be shown on the screen. Select the one you 
wish to use and click Next.

If the software searched only one machine, the confirmation 
window appears.

6. After the installation is finished, a window asking you to print a test page 
appears. If you want to print a test page, click Print a test page.
Otherwise, just click Next and skip to step 8.

7. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

8. If you want to register your machine on Samsung web site, click On-line 
Registration.

9. Click Finish.
If the printer driver does not work properly, follow the steps below to 
repair or reinstall the driver. 
a)Make sure that the machine is connected to your machine and 

powered on.
b)From the Start menu, select Programs or All Programs > 

Samsung Printers > your printer driver name > Maintenance.
c)Select the option you wish to execute, then follow the instruction on 

the window.

Macintosh
The software CD that came with your machine provides you with the PPD 
file that allows you to use the CUPS driver or Apple LaserWriter driver (only 
available when you use a machine which supports the PostScript driver) for 
printing on a Macintosh computer. 
1. Make sure that the machine is connected to your computer and powered 

on.
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Read the license agreement and click Continue.
9. Click Agree to agree to the license agreement.
10. Select Easy Install and click Install. Easy Install is recommended for 

most users. All components necessary for machine operations will be 
installed. 
If you select Custom Install, you can choose individual components to 
install.

11. When the message which warns that all applications will close on your 
computer appears, click Continue.

12. After the installation is finished, click Quit.
13. Open the Applications folder > Utilities > Print Setup Utility.

•For Mac OS X 10.5~10.6, open the Applications folder > System 
Preferences and click Print & Fax.

14. Click Add on the Printer List.
•For Mac OS X 10.5~10.6, click the “+” icon; a display window will pop 

up.
15. For Mac OS X 10.3, select the USB tab. 

•For Mac OS X10.4, click Default Browser and find the USB 
connection.

•For Mac OS X 10.5~10.6, click Default and find the USB connection.
16. For Mac OS X 10.3, if Auto Select does not work properly, select 

Samsung in Printer Model and your machine name in Model Name.
•For Mac OS X 10.4, if Auto Select does not work properly, select 

Samsung in Print Using and your machine name in Model.
•For Mac OS X 10.5~10.6, if Auto Select does not work properly, select 

Select a driver to use... and your machine name in Print Using.
Your machine appears on the Printer List, and is set as the default 
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machine.
17. Click Add.

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow steps below to uninstall the driver for Macintosh.
a)Make sure that the machine is connected to your computer and 

powered on.
b)Insert the supplied software CD into your CD-ROM drive.
c)Double-click CD-ROM icon that appears on your Macintosh desktop.
d)Double-click the MAC_Installer folder.
e)Double-click the Installer OS X icon.
f)Enter the password and click OK.
g)The Samsung Installer window opens. Click Continue.
h)Select Uninstall and click Uninstall.
i)When the message which warns that all applications will close on 

your computer appears, Click Continue.
j)When the uninstall is done, click Quit.

Linux
You need to download Linux software packages from the Samsung website 
to install the printer software. 
Follow the steps below to install the software.

Installing the Unified Linux Driver
1.Make sure that the machine is connected to your computer and 

powered on.
2.When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3.From the Samsung website, download the Unified Linux Driver 
package to your computer.

4.Right click the Unified Linux Driver package and extract the package. 
5.Double click cdroot > autorun.
6.When the welcome screen appears, click Next.

7.When the installation is complete, click Finish.
The installation program added the Unified Driver Configurator desktop 
icon and the Unified Driver group to the system menu for your 
convenience. If you have any difficulties, consult the on screen help that 
is available through your system menu or from the driver package 
Windows applications, such as Unified Driver Configurator.

If the printer driver does not work properly, uninstall the driver and 

reinstall it. 
Follow the steps below steps to uninstall the driver for Linux.
a)Make sure that the machine is connected to your computer and 

powered on.
b)When the Administrator Login window appears, type in “root” 

in the Login field and enter the system password.
You must log in as a super user (root) to uninstall the printer 
driver. If you are not a super user, ask your system 
administrator.

c)Click the icon at the bottom of the desktop. When the Terminal 
screen appears, type in:
[root@localhost root]#cd /opt/Samsung/mfp/uninstall/
[root@localhost uninstall]#./uninstall.sh

d)Click Uninstall.
e)Click Next.
f)Click Finish.

Installing the SmartPanel
1.Make sure that the machine is connected to your computer and 

powered on.
2.When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3.From the Samsung website, download the Smart Panel package to 
your computer.

4.Right click the Smart Panel package and extract the package. 
5.Double click cdroot > Linux > smartpanel > install.sh.

Installing the Printer Settings Utility
1. Make sure that the machine is connected to your computer and 

powered on.
2. When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3. From the Samsung website, download the Printer Settings Utility 
package to your computer.

4. Right-click the Printer Settings Utility package and extract the 
package.

5. Double click cdroot > Linux > psu > install.sh.
If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow the steps below to uninstall the driver for Linux.
a) Make sure that the machine is connected to your computer and 

powered on.
b) When the Administrator Login window appears, type in “root” 

in the Login field and enter the system password.
You must log in as a super user (root) to uninstall the printer 
driver. If you are not a super user, ask your system 
administrator.

c) Click the icon at the bottom of the desktop. When the Terminal 
screen appears, type in:
[root@localhost root]#cd /opt/Samsung/mfp/uninstall/
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[root@localhost uninstall]#./uninstall.sh
d) Click Uninstall.
e) Click Next.
f) Click Finish.
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3.wireless network setup 
This chapter gives you step-by-step instructions for setting up the wireless network connected machine and software.
This chapter includes:
• Network environment
• Introducing useful network programs
• Getting started
• Choosing the wireless network installation type

• Setting a wireless network with the WPS button
• Setting a wireless network from the computer
• Completing the installation
• Troubleshooting

For more information about the network environment  network 
programs, and installing a network connected machine’s driver, refer 
to the following chapters:
• See "Network environment" on page 28.
• See "Introducing useful network programs" on page 28.

Network environment
You need to set up the network protocols on the machine to use it as your 
network machine. You can set up the basic network settings through the 
machine's control panel or network setting programs.
The following table shows the network environments supported by the 
machine:

Item Requirements

Network interface • 802.11 b/g/n wireless LAN 

Network operating system • Windows 2000/Server 2003 /Server 
2008/XP/Vista/7/Server 2008 R2

• Various Linux OS
• Mac OS X 10.3 ~ 10.6

Network protocols • TCP/IPv4
• DHCP, BOOTP
• DNS, WINS, Bonjour, SLP, UPnP
• Standard TCP/IP Printing (RAW), LPR, 

IPP
• SNMPv 1/2/3, HTTP, IPSec
• TCP/IPv6 (DHCP, DNS, RAW, LPR, 

SNMPv 1/2/3, HTTP, IPSec)

Wireless security • Authentication: Open System, Shared 
Key, WPA Personal, WPA2 Personal 
(PSK)

• Encryption: WEP64, WEP128, TKIP, 
AES

Introducing useful network programs
There are several programs available to setup the network settings easily in 
network environment. For the network administrator especially, managing 
several machines on the network is possible.

Before using the programs below, set the IP address first.

SyncThru™ Web Service
Web server embedded on your network machine, which allows you to:

• Configure the network parameters necessary for the machine to connect 
to various network environments.

• Customize machine settings.
See "Using SyncThru™ Web Service" on page 53.

SyncThru™ Web Admin Service
A web-based machine management solution for network administrators. 
SyncThru™ Web Admin Service provides you with an efficient way of 
managing network devices and lets you remotely monitor and troubleshoot 
network machines from any site with corporate internet access. Download 
this program from http://solution.samsungprinter.com.

Getting started
Choosing your network connection
Typically, you can only have one connection between your computer and 
the machine at a time. There are two types of network connections to 
consider: 
• Wireless network without access Point (Ad-Hoc mode) 
• Wireless network with an access Point (Infrastructure mode) 

Infrastructure mode
This is an environment generally used for homes 
and SOHOs (Small Office/ Home Office). This 
mode uses an access point to communicate with 
the wireless machine.
• See "Installing the machine on a wireless 

network with an access point (Windows)" on 
page 30.

• See "Installing the machine on a wireless 
network with an access point (Macintosh)" on 
page 33.

Ad-Hoc mode
This mode does not use an access point. The 
wireless computer and wireless machine 
communicates directly. 
• See "Installing the machine on an Ad-Hoc 

wireless network (Windows)" on page 31.
• See "Installing the machine on an Ad-Hoc 

wireless network (Macintosh)" on page 34.

After choosing your configuration, follow the simple directions for your 
computer’s operating system, but first locate the software CD supplied 
with the machine before proceeding.
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Wireless network name and network key
Wireless networks require higher security, so when an access point is first 
set up, a network name (SSID), the type of security used, and a Network 
Key are created for the network. Locate this information before proceeding 
with the machine installation.

Printing network configuration report
In ready mode, press and hold the  (WPS button) for about 15 seconds. 
You can find your machine’s MAC address and IP address.
For example:
• MAC Address: 00:15:99:41:A2:78
• IP Address: 192.0.0.192

Choosing the wireless network installation type
There are various ways to install the wireless network to connect to the 
machine. You can install a wireless network from the machine’s control 
panel or the computer. For most users, we recommend using the WPS 
( ) button to configure the wireless network settings.

From the control panel
• WPS ( ) : If your machine and an access point (or wireless router) 

support Wi-Fi Protected Setup™(WPS), you can easily configure the 
wireless network settings by pressing the WPS ( ) button on the 
control panel. (See "Setting a wireless network with the WPS button" on 
page 29).

From the computer
From the compurter, we recommend using a USB cable with the 
program provided in the supplied software CD.
• With a USB cable: You can simply set up a wireless network using the 

program on the supplied software CD. Only Windows and Macintosh 
operating system are supported (See "Setting a wireless network with 
USB cable" on page 30).

You can also install a wireless network in Printer Settings Utility 
with a USB cable after installing the driver (Windows and 
Macintosh operating systems are supported).

Setting a wireless network with the WPS button

You can install a wireless network with the WPS ( ) button. 

After compleleting the wireless network connection, you need to install 
a machine driver to print from an application.

Setting a wireless network with the WPS button
If your machine and an access point (or wireless router) support Wi-Fi 
Protected Setup™(WPS), you can easily configure the wireless network 
settings by pressing the WPS ( ) button on the control panel.

Items to prepare
You need to ensure you have the following items ready to use:
• Check if the access point (or wireless router) supports Wi-Fi 

Protected Setup™ (WPS).

• Check if your machine supports Wi-Fi Protected Setup™ (WPS).
• Networked computer (PIN mode only)

Choosing your network connection
There are two methods to connect your machine to a wireless network 

using the WPS ( ) button on the control panel.
The Push Button Configuration (PBC) method allows you to connect 
your machine to a wireless network by pressing both the WPS ( )
button on the control panel of your machine and the WPS (PBC) button 
on a Wi-Fi Protected Setup™(WPS)-enabled access point (or wireless 
router) respectively.
The Personal Identification Number (PIN) method helps you connect 
your machine to a wireless network by entering the supplied PIN 
information on a Wi-Fi Protected Setup™(WPS)-enabled access point 
(or wireless router).
Factory default in your machine is PBC mode, which is recommended 
for a typical wireless network environment.

Connecting to a wireless network in PBC mode
To connect your machine to the wireless network in PBC mode, follow 
the following steps: 
You need to check the status of the wireless LED.

1. Press and hold the WPS ( ) button on the control panel for about 
2 - 4 seconds until the status LED blinks quickly.
• : The light blinks slowly on wireless LED. The machine 

starts connecting to the wireless network. The LED blinks slowly 
for up to two minutes until you press the PBC button on access 
point (or wireless router).

2. : Press the WPS (PBC) button on the access point (or wireless 
router).
The wireless LED blinks in the order below:

a) : The light blinks fast on the wireless LED. The machine is 
connecting to the access point (or wireless router). 

b) : When the machine is successfully connected to the 
wireless network, the wireless LED light stays on.

Connecting to the wireless network in PIN mode
To connect your machine to the wireless network, follow the following 
steps: 
You need to check the status of the wireless LED.
1. Print the network configuration report including PIN number must be 

printed. 
In ready mode, press and hold the WPS ( ) button on the control 
panel for about 15 seconds. You can find you machine’s PIN 
number.

2. Press and hold the WPS button on the control panel for 
more than 4 seconds until the status LED on.
• : The light blinks slowly on the wireless LED. The machine 

starts connecting to access point (or wireless router).
3. You need to enter eight-digit PIN number within two minutes to the 

computer which is connected to the access point (or wireless router).
The LED blinks slowly for up to two minutes until you enter the 
eight-digit PIN number
The wireless LED blinks in the order below:
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a) : The light blinks fast on the wireless LED. The machine is 
connecting to the access point (or wireless router).

b) : When the machine is successfully connected to the 
wireless network, the wireless LED light stays on.

Re-connecting to the wireless network
When the wireless function is off, the machine automatically tries to 
re-connect to the access point (or wireless router) with the previously 
used wireless connection settings and address.

In the following cases, the machine automatically re-connects to 
the wireless network:
• The machine is turned off and on again.
• The access point (or wireless router) is turned off and on again.

Canceling a wireless network connection process
To cancel the wireless network connection function when the machine is 
connecting to the wireless network, press and release the Power ( )
button on the control panel. You need to wait 2 minuites to re-connect 
the wireless network.

Disconnecting a wireless network connection
To disconnect the wireless network connection, press the WPS ( )
button on the control panel for more than two seconds.
• When the Wi-Fi Network is in idle mode: The machine is 

immediately disconnected from the wireless network, and the 
wireless LED is off.

• When the Wi-Fi Network is being used: While the machine waits 
until the current job is finished, the light blinks fast on the wireless 
LED. Then, the wireless network connection is automatically 
disconnected. The wireless LED is off.

When the Wi-Fi Network is disconnected, press the WPS ( )
button on the control panel. The Wi-Fi network is on and the 
setting a wireless network begins.

Setting a wireless network from the computer
You can install a wireless network with a USB cable from the computer.

Setting a wireless network with USB cable
See your network administrator, or the person that set up your 
wireless network, for information about your network configuration.

Installing the machine on a wireless network with an 
access point (Windows)
Items to prepare
Ensure you have the following items ready.
• Access point
• Network-connected computer
• Software CD that was provided with your machine
• The machine installed with a wireless network interface
• USB cable

Creating the infrastructure network in Windows
When the items are ready, follow the steps below:
1. Check whether the USB cable is connected to the machine.
2. Turn on your computer, access point, and machine.

3. Insert the supplied software CD into your CD-ROM drive.
• The software CD should automatically run and an installation 

window appear.
• If the installation window does not appear, click on Start and then 

Run. Type X:\Setup.exe, replacing “X” with the letter which 
represents your drive. Click on OK.

• If you use Windows Vista, Windows 7, or Windows Server 2008 
R2 click on Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter that represents 
your drive and click on OK.

• If the AutoPlay window appears in Windows Vista, Windows 7, 
or Windows Server 2008 R2, click on Run Setup.exe in Install 
or run program field, and click on Continue or Yes in the User 
Account Control window.

4. Select the Wireless Setting and Installation option.

• Install Now: If you have already set up the wireless network, 
click on this button to install the machine driver to use the 
wireless network machine. If you have not set up the wireless 
network, click on the Wireless Setting and Installation button to 
set up the wireless network before you click on this button. 

• Wireless Setting and Installation: Configure the wireless 
network settings of your machine with a USB cable then install 
the machine driver. Only for the users who have not set up the 
wireless connection before.

5. Read the License Agreement, and select I accept the terms of the 
License Agreement. Then, click on Next.

6. The software searches the wireless network.

If the search has failed, you may check if the USB cable is 
properly connected between the computer and machine, and 
follow the instructions on the window.

7. After searching, the window shows the wireless network devices. 
Select the name (SSID) of the access point you are using and click 
on Next.

If you cannot find out the network name you want to choose, or 
if you want to set the wireless configuration manually, click on 
Advanced Setting.
• Enter the wireless Network Name: Enter the SSID of 

access point you want (SSID is case-sensitive).
• Operation Mode: Select Infrastructure.
• Authentication: Select an authentication type.

Open System: Authentication is not used, and encryption 
may or may not be used, depending on the need for data 
security.
Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.
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WPA Personal or WPA2 Personal: Select this option to 
authenticate the print server based on WPA Pre-Shared 
Key. This uses a shared secret key (generally called Pre- 
Shared Key pass phrase) which is manually configured on 
the access point and each of its clients.

• Encryption: Select the encryption (None, WEP64, 
WEP128, TKIP, AES, TKIP AES).

• Network Key: Enter the encryption network key value.
• Confirm Network Key: Confirm the encryption network 

key value.
• WEP Key Index: If you are using WEP Encryption, select 

the appropriate WEP Key Index.

The wireless network security window appears when the 
access point has security setting.
The wireless network security window appears. The window 
may differ according to its security mode, WEP, or WPA.
• In case of WEP

Select Open System or Shared Key for the authentication 
and enter WEP security key. Click on Next.
WEP (Wired Equivalent Privacy) is a security protocol 
preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.

• In case of WPA
Enter the WPA shared key and click on Next.
WPA authorizes and identifies users based on a secret key 
that changes automatically at regular intervals. WPA also 
uses TKIP (Temporal Key Integrity Protocol) and AES 
(Advanced Encryption Standard) for data encryption.

8. The window shows the wireless network settings and check if the 
settings are right. Click on Next.
• For the DHCP method

If the IP address assignment method is DHCP, check if DHCP is 
shown in the window. However, if it shows Static, click on 
Change TCP/IP to change the assignment method to DHCP.

• For the Static method
If the IP address assignment method is Static, check if Static is 
shown in the window. However, if it shows DHCP, click on 
Change TCP/IP to enter the IP address and other network 
configuration values for the machine. Before entering the IP 
address for the machine, you must know the computer’s network 
configuration information. If the computer is set to DHCP, you 
must contact the network administrator to get the static IP 
address.
For example:
If computer’s network information is as shown below:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as below:
- IP address: 169.254.133. 43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet 

mask.)
- Gateway: 169.254.133.1

9. When the wireless network setting is completed, disconnect the USB 
cable between the computer and machine. Click on Next.

10. The Wireless Network Setting Complete window appears.
Select Yes if you accept the current settings and continue the setup 

procedure.
Select No if you want to return to the beginning screen. 
Then, click on Next.

11. Click on Next when the Confirm Printer Connection window 
appears.

12. Select the components to be installed. Click on Next.
After selecting the components, you can also change the machine 
name, set the machine to be shared on the network, set the machine 
as the default machine, and change the port name of each machine. 
Click on Next.

13. After the installation is finished, a window asking you to print a test 
page appears. If you want to print a test page, click on Print a test 
page.
Otherwise, just click on Next and go to step 15.

14. If the test page prints out correctly, click on Yes.
If not, click on No to reprint it.

15. To register as a user of the machine in order to receive information 
from Samsung, click on On-line Registration.

16. Click on Finish.

Installing the machine on an Ad-Hoc wireless network 
(Windows)
If you do not have an access point (AP), you may still connect the 
machine wirelessly to your computer by setting up an Ad-Hoc wireless 
network by following the simple steps below.

Items to prepare
Ensure you have the following items ready:
• Network-connected computer
• Software CD that was provided with your machine
• The machine installed with a wireless network interface
• USB cable

Creating the Ad-Hoc network in Windows
When the items are ready, follow the steps below:
1. Check whether the USB cable is connected to the machine.
2. Turn on your computer and the wireless network machine.
3. Insert the supplied software CD into your CD-ROM drive.

• The software CD should automatically run and an installation 
window appear.

• If the installation window does not appear, click on Start and then 
Run. Type X:\Setup.exe, replacing “X” with the letter which 
represents your drive. Click on OK.

• If you use Windows Vista, Windows 7, or Windows Server 2008 
R2 click on Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter that represents 
your drive and click on OK.

• If the AutoPlay window appears in Windows Vista, Windows 7, 
or Windows Server 2008 R2, click on Run Setup.exe in Install 
or run program field, and click on Continue or Yes in the User 
Account Control window.
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4. Select the Wireless Setting and Installation option.

• Install Now: If you have set the wireless network, click on this 
button to install the machine driver to use the wireless network 
machine. If you have not set the wireless network, click on 
Wireless Setting and Installation button to set the wireless 
network before you click on this button. 

• Wireless Setting and Installation: Configure the wireless 
network settings of your machine with a USB cable then install 
the machine driver. Only for users who have not set up the 
wireless connection before.

5. Read the License Agreement, and select I accept the terms of the 
License Agreement. Then, click on Next.

6. The software searches the wireless network.

If the software has failed to search the network, check if the 
USB cable is connected properly between the computer and 
machine, and follow the instruction on the window.

7. After searching the wireless networks, a list of wireless networks 
your machine has searched appears. 
If you want to use the Samsung default ad-hoc setting, select the last 
wireless network on the list, Network Name(SSID) is portthru and 
Signal is Printer Self Network.
Then, click on Next.
If you want to use other ad-hoc settings, select another wireless 
network from the list. 

If you want to change ad-hoc settings click on the Advanced 
Setting button
• Enter the wireless Network Name: Enter the SSID name 

you want (SSID is case-sensitive).
• Operation Mode: Select Ad-hoc.
• Channel: Select the channel. (Auto Setting or 2412 MHz 

to 2467 MHz).
• Authentication: Select an authentication type.

Open System: Authentication is not used, and encryption 
may or may not be used, depending on the need for data 
security.
Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.

• Encryption: Select the encryption (None, WEP64, 
WEP128).

• Network Key: Enter the encryption network key value.
• Confirm Network Key: Confirm the encryption network 

key value.
• WEP Key Index: If you are using the WEP Encryption, 

select the appropriate WEP Key Index.

The wireless network security window appears when the 
ad-hoc network has security setting.
The wireless network security window appears. Select Open 
System or Shared Key for the authentication and click on 
Next.
• WEP (Wired Equivalent Privacy) is a security protocol 

preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.

8. The window showing the wireless network setting appears. Check 
the settings and click on Next.

Before entering the IP address for the machine, you must know 
the computer’s network configuration information. If the 
computer’s network configuration is set to DHCP, the wireless 
network setting should also be DHCP. Likewise, if the 
computer’s network configuration is set to Static, the wireless 
network setting should also be Static.
If your computer is set to DHCP and you want to use the Static 
wireless network setting, you must contact the network 
administrator to get the static IP address.
• For the DHCP method

If the IP address assignment method is DHCP, check if 
DHCP is shown in the Wireless Network Setting Confirm
window. However, if it shows Static, click on Change
TCP/IP to change the assignment method to Receive IP 
address automatically (DHCP).

• For the Static method
If the IP address assignment method is Static, check if 
Static is shown in the Wireless Network Setting Confirm 
window. However, if it shows DHCP, click on Change 
TCP/IP to enter the IP address and other network 
configuration values for the machine.
For example:
If computer’s network information is as shown below:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as 
below:
- IP address: 169.254.133. 43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet 

mask.)
- Gateway: 169.254.133.1

9. When the wireless network setting is completed, disconnect the USB 
cable between the computer and machine. Click on Next.

If the Change PC Network Setting window appears, follow 
the steps on the window.
Click on Next if you are finished the computer’s wireless 
network settings.
If you set the computer’s wireless network on DHCP, it will take 
several minutes to receive the IP address.

10. The Wireless Network Setting Complete window appears.
Select Yes if you accept the current settings and continue the setup 
procedure.
Select No if you want to return to the beginning screen. 
Then, click on Next.
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11. Click on Next when the Confirm Printer Connection window 
appears.

12. Select the components to be installed. Click on Next.
After selecting the components, you can also change the machine 
name, set the machine to be shared on the network, set the machine 
as the default machine, and change the port name of each machine. 
Click on Next.

13. After the installation is finished, a window asking you to print a test 
page appears. If you want to print a test page, click on Print a test 
page.
Otherwise, just click on Next and go to step 15.

14. If the test page prints out correctly, click on Yes.
If not, click on No to reprint it.

15. To register as a user of the machine in order to receive information 
from Samsung, click on On-line Registration.

16. Click on Finish.

Installing the machine on a wireless network with an 
access point (Macintosh)
Items to prepare
Ensure you have the following items ready:
• Access point
• Network-connected computer
• Software CD that was provided with your machine
• The machine installed with a wireless network interface
• USB cable

Creating the infrastructure network in Macintosh
When the items are ready, follow the steps below:
1. Check whether the USB cable is connected to the machine.
2. Turn on your computer, access point, and machine.
3. Insert the supplied software CD into your CD-ROM drive.
4. Double-click the CD-ROM icon that appears on your Macintosh 

desktop.
5. Double-click the MAC_Installer folder.
6. Double-click the Installer OS X icon.
7. Enter the password and click on OK.
8. The Samsung Installer window opens. Click on Continue.
9. Read the license agreement and click on Continue.
10. Click on Agree to agree to the license agreement.
11. The Samsung Installer window opens. Click on Continue.
12. Select Easy Install and click on Install. Easy Install is 

recommended for most users. All compoenets necessary for 
machine operations will be installed.
If you select Custom Install, you can choose individual operations 
will be installed.

13. Select the Wireless Setting and Installation option.
14. The software searches the wireless network.

If the search has failed, you may check if the USB cable is 
connected between the computer and machine properly, and 
follow the instructions in the window.

15. After searching, the window shows the wireless network devices. 
Select the name (SSID) of the access point you are using and click 
on Next.

When you set the wireless configuration manually, click on 
Advanced Setting.

• Enter the wireless Network Name: Enter the SSID of 
access point you want (SSID is case-sensitive).

• Operation Mode: Select Infrastructure.
• Authentication: Select an authentication type.

Open System: Authentication is not used, and encryption 
may or may not be used, depending on the need for data 
security.
Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.
WPA Personal or WPA2 Personal: Select this option to 
authenticate the print server based on WPA Pre-Shared 
Key. This uses a shared secret key (generally called Pre- 
Shared Key pass phrase) that is manually configured on 
the access point and each of its clients.

• Encryption: Select the encryption. (None, WEP64, 
WEP128, TKIP, AES, TKIP AES)

• Network Key: Enter the encryption network key value.
• Confirm Network Key: Confirm the encryption network 

key value.
• WEP Key Index: If you are using the WEP Encryption, 

select the appropriate WEP Key Index.

The wireless network security window appears when the 
access point has security setting.
The wireless network security window appears. The window 
may differ according to its security mode: WEP or WPA.
• In case of WEP

Select Open System or Shared Key for the authentication 
and enter WEP security key. Click on Next.
WEP (Wired Equivalent Privacy) is a security protocol 
preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.

• In case of WPA
Enter the WPA shared key and click on Next.
WPA authorizes and identifies users based on a secret key 
that changes automatically at regular intervals. WPA also 
uses TKIP (Temporal Key Integrity Protocol) and AES 
(Advanced Encryption Standard) for data encryption.

16. The window shows the wireless network setting and check if settings 
are right. Click on Next.
• For the DHCP method

If the IP address assignment method is DHCP, check if DHCP is 
shown in the window. However, if it shows Static, click on 
Change TCP/IP to change the assignment method to DHCP.

• For the Static method
If the IP address assignment method is Static, check if Static is 
shown in the window. However, if it shows DHCP, click Change
TCP/IP to enter the IP address and other network configuration 
values for the machine. Before entering the IP address for the 
machine, you must know the computer’s network configuration 
information. If the computer is set to DHCP, you must contact the 
network administrator to get the static IP address.
For example:
If computer’s network information is as shown below:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as below:
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- IP address: 169.254.133. 43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet 

mask.)
- Gateway: 169.254.133.1

17. The wireless network connects according to the network 
configuration.

18. When the wireless network setting is completed, disconnect the USB 
cable between the computer and machine. 

19. Follow the instructions on the screen to complete the installation. 
After the installation is finished, click on Quit or Restart.

Installing the machine on an Ad-Hoc wireless network 
(Macintosh)
If you do not have a access point (AP), you may still connect the 
machine wirelessly to your computer by setting up an Ad-Hoc wireless 
network by following these simple directions.

Items to prepare
Ensure you have following items ready:
• Network-connected computer
• Software CD that provided with your machine
• The machine installed with a wireless network interface
• USB cable

Creating the Ad-Hoc network in Macintosh
When the items are ready, follow these steps:
1. Check whether the USB cable is connected to the machine.
2. Turn on your computer and machine.
3. Insert the supplied software CD into your CD-ROM drive.
4. Double-click the CD-ROM icon that appears on your Macintosh 

desktop.
5. Double-click the MAC_Installer folder.
6. Double-click the Installer OS X icon.
7. Enter the password and click on OK.
8. The Samsung Installer window opens. Click on Continue.
9. Read the license agreement and click on Continue.
10. Click on Agree to agree to the license agreement.
11. Select Easy Install and click on Install. Easy Install is 

recommended for most users. All components necessary for 
machine operations will be installed.
If you select Custom Install, you can choose individual operations 
will be installed.

12. Click on Wireless Setting and Installation.
13. The software searches the wireless network devices.

If the search has failed, you may check if the USB cable is 
connected between the computer and machine properly, and 
follow the instruction on the window.

14. After searching the wireless networks, a list of wireless networks 
your machine has searched appears. 
If you want to use the Samsung default ad-hoc setting, select the last 
wireless network on the list, which Network Name(SSID) is portthru
and Signal is Printer Self Network.
Then, click on Next.
If you want to use other ad-hoc settings, select another wireless 
network from the list. 

If you want to change ad-hoc settings click the Advanced 
Setting button

• Enter the wireless Network Name: Enter the SSID name 
you want (SSID is case-sensitive).

• Operation Mode: Select Ad-hoc.
• Channel: Select the channel (Auto Setting or 2412 MHz 

to 2467 MHz).
• Authentication: Select an authentication type.

Open System: Authentication is not used, and encryption 
may or may not be used, depending on the need for data 
security.
Shared Key: Authentication is used. A device that has a 
proper WEP key can access the network.

• Encryption: Select the encryption (None, WEP64, 
WEP128).

• Network Key: Enter the encryption network key value.
• Confirm Network Key: Confirm the encryption network 

key value.
• WEP Key Index: If you are using the WEP Encryption, 

select the appropriate WEP Key Index.

The wireless network security window appears when the 
ad-hoc network has security setting.
The wireless network security window appears. Select Open 
System or Shared Key for the authentication and click on 
Next.
• WEP (Wired Equivalent Privacy) is a security protocol 

preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged 
on a wireless network using a 64-bit or 128-bit WEP 
encryption key.

15. The window showing the wireless network setting appears. Check 
the settings and click on Next.

Before entering the IP address for the machine, you must know 
the computer’s network configuration information. If the 
computer’s network configuration is set to DHCP, the wireless 
network setting should also be DHCP. Likewise, if the 
computer’s network configuration is set to Static, the wireless 
network setting should also be Static.
If your computer is set to DHCP and you want to use Static 
wireless network setting, you must contact the network 
administrator to get the static IP address.
• For the DHCP method

If the IP address assignment method is DHCP, check if 
DHCP is shown in the Wireless Network Setting Confirm 
window. However, if it shows Static, click on Change
TCP/IP to change the assignment method to Receive IP 
address automatically (DHCP).

• For the Static method
If the IP address assignment method is Static, check if 
Static is shown in the Wireless Network Setting Confirm 
window. However, if it shows DHCP, click on Change 
TCP/IP to enter the IP address and other network 
configuration values for the machine.
For example:
If computer’s network information is as shown below:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as 
below:
- IP address: 169.254.133. 43
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- Subnet Mask: 255.255.0.0 (Use the computer’s subnet 
mask.)

- Gateway: 169.254.133.1
16. The wireless network connects according to the network 

configuration.
17. When the wireless network setting is completed, disconnect the USB 

cable between the computer and machine. 
18. Follow the instructions on the screen to complete the installation. 

After the installation is finished, click on Quit or Restart.

Completing the installation
After you have installed your Samsung wireless network printer, print 
another copy of the Network Configuration Report and keep it for future 
reference. You are now ready to use your new Samsung wireless printer on 
your network. 

If the wireless network seems to not be working, set all the network 
setting to the factory defaults and try again (See "Restoring factory 
default settings using SyncThru™ Web Service" on page 35).

Restoring factory default settings using 
SyncThru™ Web Service
1. Start a web browser such as Internet Explorer, Safari or Firefox and 

enter your machine’s new IP address in the browser window.
For example,

2. Click Go to access the SyncThru™ Web Service.
3. Click Login on the upper right of the SyncThru™ Web Service website.

A log-in page appears. 
4. Type in the ID and Password then click Login.

If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
• ID: admin
• Password: sec00000

5. When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Restore Default.

6. Click Clear for network.
7. Turn off and restart machine to apply settings.

Troubleshooting
Solving problems that might occur during setting up 
the wireless setting and installing the machine driver

Printers Not Found
• Your machine may not be turned on. Turn on your computer and the 

machine.
• USB cable is not connected between your computer and machine. 

Connect machine to your computer using the USB cable.
• The machine does not support a wireless network. Check the 

machine's user's guide included on the software CD supplied with 
your machine and prepare a wireless network machine.

Connecting Failure - Not Found SSID
• The machine is unable to search the network name (SSID) you have 

selected or entered. Check the network name (SSID) on your access 
point and try connecting again. 

• Your access point is not turned on. Turn on your access point.

Connecting Failure - Invalid Security
• You configured security incorrectly. Check the configured security on 

your access point and machine.

Connecting Failure - General Connection Error
• Your computer is not receiving a signal from your machine. Check 

the USB cable and your machine’s power.

PC Connection Error
• The configured network address is unable to connect between your 

computer and machine.
- For a DHCP network environment

The print receives the IP address automatically (DHCP) when 
computer is configured to DHCP.

- For a Static network environment
The machine uses the static address when the computer is 
configured to static address.
For example:
If computer’s network information is as shown below:
- IP address: 169.254.133.42
- Subnet Mask: 255.255.0.0
Then, the machine’s network information should be as below:
- IP address: 169.254.133. 43
- Subnet Mask: 255.255.0.0 (Use the computer’s subnet 

mask.)
- Gateway: 169.254.133.1

Solving other problems
If problems occur while using the machine on a network, check the 
following: 

For information on the access point (or wireless router), refer to its 
own user's guide. 

• Your computer, access point (or wireless router), or machine may not be 
turned on.

• Check the wireless reception around the machine. If the reception is far 
from the machine or there is an obstacle, you might have difficulty 
receiving the signal. 

• Cycle the power for the access point (or wireless router), machine, and 
computer. Sometimes cycling the power can recover network 
communication.

• Check whether firewall software (V3 or Norton) is blocking the 
communication. 
If the computer and the machine is connected on the same network and 
it cannot be searched, firewall software might be blocking the 
communication. Refer to the user's guide for the software to turn it off 
and try searching for the machine again.

• Check whether the machine's IP address is allocated correctly. You can 
check the IP address by printing the network configuration report.

• Check whether the access point (or wireless router) has a configured 
security (password). If it has a password, refer to the access point (or 
wireless router) administrator.

• Check whether the machine's IP address. Reinstall the machine driver 
and change the settings to connect to the machine on the network. Due 
to the characteristics of DHCP, the allocated IP address could change if 
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the machine is not used for a long time or if the access point has been 
reset.

• Check the wireless environment. You might not be able to connect to the 
network in the infrastructure environment where you need to type in a 
user's information before connecting to access point (or wireless router).

• This machine only supports IEEE 802.11 b/g/n and Wi-Fi. Other wireless 
communication (Bluetooth) is not supported.

• When using the Ad-hoc mode, for operating systems such as Windows 
Vista, you might need to set the wireless connection setting every time 
you use the wireless machine. 

• You cannot use infrastructure mode and Ad-hoc mode at the same time 
for Samsung wireless network machines.

• The machine is within the range of the wireless network.
• The machine is located away from obstacles that could block the 

wireless signal.
Remove any large metal objects between the access point (or wireless 
router) and the machine.
Make sure the machine and wireless access point (or wireless router) 
are not separated by poles, walls, or support columns containing metal 
or concrete.

• The machine is located away from other electronic devices that may 
interfere with the wireless signal.
Many devices can interfere with the wireless signal, including a 
microwave oven and some Bluetooth devices.
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4.basic setup
After installation is complete, you may want to set the machine’s default settings. Refer to the next section if you would like
to set or change values. This chapter gives you step-by-step instructions for setting up the machine.
This chapter includes:
• Setting the default tray and paper • Altitude adjustment

SETTING THE DEFAULT TRAY AND PAPER
You can select the tray and paper you would like to keep using for printing 
job.

From your computer
Windows
1. Click the Windows Start menu. 
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printer and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
• For Windows 7, select Control Panel > Hardware and Sound >

Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware 

> Devices and Printers.
3.Right-click on your machine.
4. For Windows XP/2003/2008/Vista, press Printing Preferences.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printing Preferences.

If Printing Preferences item has a  mark, you can select 
other printer drivers connected with the selected printer.

5. Click Paper tab. 
6.Select tray and its options, such as paper size and type.
7. Press OK.

If you want to use special-sized paper such as a billing paper, 
select Edit... in the Paper tab in the Printing Preferences. (See 
"Opening printing preferences" on page 44.)

Macintosh
Macintosh does not support this function. Macintosh users need to 
change the default setting manually each time they want to print using 
other settings. 
1.Open a Macintosh application and select the file you want to print.
2. Open the File menu and click Print.
3. Go to Paper Feed pane.
4.Set appropriate tray from which you want to print.
5. Go to Paper pane.
6.Set paper type to correspond to the paper loaded in the tray from 

which you want to print.
7. Click Print to print. 

Linux
1. Open Terminal Program.
2. When the Terminal screen appears, type in the following: 

[root@localhost root]# lpr <FileName>
3. Select Printer and click Properties…
4. Click on the Advanced tab.
5.Select the tray (source) and its options, such as paper size and type.
6. Press OK.

ALTITUDE ADJUSTMENT
The print quality is affected by atmospheric pressure, which is determined 
by the height of the machine above sea level. The following information will 
guide you on how to set your machine to the best print quality or best quality 
of print.

Before you set the altitude value, determine the altitude where you are.

0

4,000 m
(13,123 ft) 

3,000 m
(9,842 ft) 

2,000 m
(6,561 ft) 

1,000 m
(3,280 ft) 

4

3

2

1

1 High 1
2 High 2
3 High 3
4 Normal

You can altitude adjustment in Printer Settings Utility.
1. Double-click the Smart Panel icon on the Windows task bar (or 

Notification Area in Linux). You can also click Smart Panel on the status 
bar in Mac OS X (See "Using the Smart Panel program" on page 51).
Or, if you are a Windows user, you can launch it from the Start menu, 
select Programs or All Programs > Samsung Printers > your printer 
driver name > Smart Panel.

2. Click Printer Setting.
3. Select necessary options in the Altitude Adjustment drop-down list.
4. Click the Apply button.

If your machine is connected to a network, SyncThru™ Web Service 
screen appears automatically. This can also be adjusted via SyncThru™ 
Web Service.
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5.media and tray
This chapter provides information on how to load print media into your machine.
This chapter includes:
• Selecting print media
• Changing the tray size
• Loading paper in the tray

• Printing on special media
• Changing the tray size

SELECTING PRINT MEDIA
You can print on a variety of print media, such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meets the 
guidelines for use with your machine and from the appropriate tray. 

Guidelines for selecting the print media
Print media that does not meet the guidelines outlined in this user’s guide 
may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear on the machine.
• Permanent fuser damage, not covered under warranty.
Properties, such as weight, composition, grain, and moisture content, are 
important factors that affect the machine’s performance and the output 
quality. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described in print media specifications. (See "Print media specifications" 
on page 70.)

• Desired outcome: The print media you choose should be appropriate for 
your project.

• Brightness: Some print media are whiter than others and produce 
sharper, more vibrant images.

• Surface smoothness: The smoothness of the print media affects how 
crisp the printing looks on the paper.

•Some print media may meet all of the guidelines in this section and 
still not produce satisfactory results. This may be the result of the 
sheets characteristics, improper handling, unacceptable 
temperature and humidity levels, or other variables over which 
cannot be controlled.

•Before purchasing large quantities of print media, ensure that it 
meets the specifications in this user’s guide and that it meets your 
output requirements. 

• Using print media that does not meet these specifications may 
cause problems, requiring repairs. Such repairs are not covered by 
the warranty or service agreements.
The amount of paper put into the tray may differ according to 
media type used. (See "Print media specifications" on page 70.)

• Using inflammable print media can cause a fire.
• Use designated print media (See "Print media specifications" on 

page 70).
The use of inflammable media or foreign materials left in the printer 
may lead to overheating of the unit and, in rare cases may cause a 
fire.

Media sizes supported in each mode
MODE SIZE TYPE SOURCE

Simplex 
printing

For details about 
paper size, see 
"Print media 
specifications" 
on page 70.

For details about 
paper type, see 
"Print media 
specifications" 
on page 70.

Tray

Duplex 
printing 
(Manual)a

a.75 to 90 g/m2 (20~24 lbs bond) only (See "Print media specifications" 
on page 70).

Letter, A4, 
Legal, US Folio, 
Oficio

Plain, Color, 
Preprinted, 
Recycled, Bond, 
Archive

Manual feeding 
in the tray

CHANGING THE TRAY SIZE
The tray is preset to Letter or A4 size, depending on your country. To 
change the size, you need to adjust the paper guides.

1 Paper width guide
2 Tray
3 Paper length guide
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1. Open front cover and pinch the paper length guide and pull it out to 
extend the tray.

Because the machine is very light, it can move when you open and 
close the tray or install and remove the toner cartridge. Be careful 
not to move the machine when performing these tasks.

2. Flex or fan the edge of the paper stack to separate the pages before 
loading the paper. Insert the paper into the tray.

3. Load paper with the print side facing up. Make sure that all four corners 
are flat in the tray.

Do not overload the tray with paper. Otherwise, it may cause paper 
jams.

4. Pinch the paper length guide to adjust the guide so that it is flush up 
against the rear edge of the paper; then pinch the paper width guides so 
they are flush against the sides of the paper.

•Do not push the paper width guide too far causing the media to 
warp.

•Do not use a paper with more than 6 mm (0.24 inch.) curl. 
•If you do not adjust the paper width guide, it may cause paper 

jams.

LOADING PAPER IN THE TRAY
Tray
1. Open the front cover, pinch the paper length guide and pull it out to 

extend the tray. Then, adjust the tray size to the media size you are 
loading. (See "Changing the tray size" on page 38.)

2. Flex or fan the edge of the paper stack to separate the pages before 
loading papers.

3. Place the paper with the side you want to print facing up.

When you print a document, set the paper type and size for the tray.
For information about setting the paper type and size on the control 
panel (See "Setting the default tray and paper" on page 37).

•If you experience problems with paper feeding, check whether the 
paper meets the media specifications. Then, try placing one 
sheet at a time in tray (See "Print media specifications" on 
page 70, "Printing on special media" on page 40).

•The settings made from the machine driver override the settings 
on the control panel.

Manual feeding in the tray
The tray can hold special sizes and types of print material, such as 
postcards, note cards, and envelopes. It is useful for single page printing on 
letterhead or colored paper.

Tips on using the manual feeding method
•If you select Paper > Source > Manual Feeder from your printer driver, 

you need to press  each time you print a page.
Load only one type, size and weight of print media at a time in the 
tray.

•To prevent paper jams, do not add media while printing. 
•Print media should be loaded face up with the top edge going into the 

tray first and be placed in the center of the tray.
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•Always load the use recommended print media to avoid paper jams and 
print quality problems. (See "Print media specifications" on page 70.)

•Flatten any curl on postcards, envelopes, and labels before loading 
them into the tray.

1.Load the paper in the tray.

•When printing on special media, you must follow the loading 
guideline. (See "Printing on special media" on page 40.)

•When paper does not feed well while printing, gently push the 
paper in manually until it starts feeding automatically. 

2.Squeeze the tray paper width guides and adjust them to the width of 
the paper. Do not force them too much, or the paper will bend 
resulting in a paper jam or skew.

3.Open the output support. 
4.To print from an application, open the application and open the print 

menu.
5.Open Printing Preferences. (See "Opening printing preferences" on 

page 44.)
6.Click on the Paper tab in Printing Preferences, and select an 

appropriate paper type.

For example, if you want to use a label, set the paper type to 
Label.

7.Select Manual Feeder in paper source, then press OK.
8.Start printing.

If you are printing multiple pages, load the next sheet after the first 
page prints out, and press the . Repeat this step for every page 
to be printed.

PRINTING ON SPECIAL MEDIA
The table below shows the available special media for printing. 

When printing on a special media, we recommend you feed one paper 
at a time. Check the maximum input number of media for tray. (See 
"Print media specifications" on page 70.)

TYPES TRAY
MANUAL

FEEDING IN 
TRAYa

Plain

Thick 

Thin 

Cotton

Color 

Preprinted 

Recycled

Envelope

Transparency

Labels

CardStock

Bond

Archive

( : supported, Blank: Not supported) 
The following media types are shown in the Printing Preferences. This 
paper type option allows you to set the type of paper to be loaded in the 
tray. Selecting the appropriate media will let you get the best printout 
quality. Selecting inappropriate media can result in poor print quality.
• Plain: Normal plain paper. Select this type if your printing on 60 to 120 

g/m2 (16 to 32 lbs).
• Thick: 90 to 163 g/m2 (24 to 43 lbs) thick paper.
• Thin: 60 to 70 g/m2 (16 to 19 lbs) thin paper.
• Cotton: 75 to 90 g/m2 (20 to 24 lbs) cotton paper.
• Color: 75 to 90 g/m2 (20 to 24 lbs) color-back grounded paper.
• Preprinted: 75 to 90 g/m2 (20 to 24 lbs) preprinted/letterhead paper.
• Recycled: 60 to 90 g/m2 (16 to 24 lbs) recycled paper.

When you use recycled paper, printouts might be wrinkled and/or 
jamming may occur due to excessive curl. 

• CardStock: 105 to 163 g/m2 (28 to 43 lbs) cardstock. 
• Envelope: 75 to 90 g/m2 (20 to 24 lbs) envelope.
• Transparency: 138 to 146 g/m2 (37 to 39 lbs) transparency paper. 
• Labels: 120 to 150 g/m2 (32 to 40 lbs) labels. 
• Bond: 105 to 120 g/m2 (28 to 32 lbs) bond. 
• Archive: 70 to 90 g/m2 (19 to 24 lbs) If you need to keep the print-out 

for a long time, such as for archives. 

a.Load one paper at a time.

TYPES TRAY
MANUAL

FEEDING IN 
TRAYa
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Envelopes
Successful printing on envelopes depends upon the quality of the 
envelopes. 
To print on an envelope, the stamp area should be on the left side and the 
end of the envelope with the stamp area should enter the printer first in the 
center of the tray.

• When selecting envelopes, consider the following factors:
-Weight: The weight of the envelope paper should not exceed 90 g/m2

otherwise, jams may occur.
-Construction: Prior to printing, envelopes should lie flat with less than 

6 mm ( 0.24 inch.) of curl, and should not contain air.
-Condition: Envelopes should not be wrinkled, nicked, nor damaged.
-Temperature: Use envelopes that are compatible with the heat and 

pressure of the machine during operation.
• Use only well-constructed envelopes with sharp-and well-creased folds.
• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, coated lining, 

self-adhesive seals, or other synthetic materials.
• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope extends all the way to 

the corner of the envelope.

1  Acceptable
2  Unacceptable

• Envelopes with a peel-off adhesive strip or with more than one flap that 
folds over to seal must use adhesives compatible with the machine’s 
fusing temperature about 170°C (338 °F) for 0.1 second. The extra flaps 
and strips might cause wrinkling, creasing, or jams, and may even 
damage the fuser.

• For the best print quality, position margins no closer than 15 mm ( 0.59 
inch.) from the edges of the envelope.

• Avoid printing over the area where the envelope’s seams meet.

Transparencies
To avoid damaging the machine, use only transparencies designed for laser 
printers.

• Transparencies used in the machine must be able to withstand 
machine’s fusing temperature.

• Place them on a flat surface after removing them from the machine.
• Do not leave unused transparencies on the paper tray for long periods of 

time. Dust and dirt may accumulate on them, resulting in spotty printing.
• To avoid smudging caused by fingerprints, handle transparencies 

carefully.
• To avoid fading, do not expose printed transparencies to prolonged 

sunlight.
• Ensure that transparencies are not wrinkled, curled, or have any torn 

edges.
• Do not use transparencies that separate from the backing sheet.
• To prevent transparencies from sticking to each other, do not let the 

printed sheets stack up as they are begin printed out. 

Labels
To avoid damaging the machine, use only labels designed for laser 
machines.

• When selecting labels, consider the following factors:
-Adhesives: The adhesive material should be stable at your machine’s 

fusing temperature (about 170°C (338 °F)). 
-Arrangement: Only use labels with no exposed backing between 

them. Labels can peel off sheets that have spaces between the 
labels, causing serious jams.

-Curl: Prior to printing, labels must lie flat with no more than 13 mm
(0.51 inch.) of curl in any direction.

-Condition: Do not use labels with wrinkles, bubbles, or other 
indications of separation.

• Make sure that there is no exposed adhesive material between labels. 



Media and tray_ 42

Exposed areas can cause labels to peel off during printing, which can 
cause paper jams. Exposed adhesive can also cause damage to 
machine components.

• Do not run a sheet of labels through the machine more than once. The 
adhesive backing is designed for only a single pass through the 
machine.

• Do not use labels that are separating from the backing sheet or are 
wrinkled, bubbled, or otherwise damaged.

Card stock/Custom-sized paper
Postcards, cards and other custom-sized materials can be printed with this 
machine.

• Do not print on media smaller than 76 mm (3.00 inches) wide or 183 mm 
(7.20 inches) long.

• In software applications, set the margins at least 6.4 mm (0.25 inches) 
away from the edges of the material.

Letterhead/Preprinted paper

SINGLE-SIDED DOUBLE-SIDED

Face up Face down

• Letterhead/ Preprinted paper must be printed with heat-resistant ink that 
will not melt, vaporize, or release hazardous emissions when subjected 
to the machine’s fusing temperature (about 170°C(338 °F) for 0.1 
second.

• Letterhead/ Preprinted paper ink must be non-flammable and should not 
adversely affect machine rollers.

• Forms and letterhead should be sealed in a moisture-proof wrapping to 
prevent changes during storage.

• Before you load letterhead/preprinted paper, verify that the ink on the 
paper is dry. During the fusing process, wet ink can come off preprinted 
paper, reducing print quality.

USING THE OUTPUT SUPPORT
The surface of the output tray may become hot if you print a large 
number of pages at once. Make sure that you do not touch the 

surface, and do not allow children near it.

The printed pages stack on the output support, and the output support will 
help the printed pages to align. The printer sends printouts to the output tray 
by default.
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6.printing
This chapter explains common printing tasks.
This chapter includes:
• Printer driver features
• Basic printing
• Opening printing preferences
• Using help
• Using special print features

• Changing the default print settings
• Setting your machine as a default machine
• Printing to a file (PRN)
• Macintosh printing
• Linux printing

The procedures in this chapter are mainly based on Windows XP.

PRINTER DRIVER FEATURES
Your printer drivers support the following standard features:
• Paper orientation, size, source, and media type selection
• Number of copies
In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer driver:

Some models or operating systems may not support some of the 
feature(s) in the following table.

Printer driver
FEATURE WINDOWS

Print quality option

Poster printing

Multiple pages per sheet 

Booklet printing (manual)

Fit to page printing

Reduce and enlarge printing

Different source for first page

Watermark

Overlay

Double-sided printing (manual)
( : supported) 

BASIC PRINTING
Your machine allows you to print from various Windows, Macintosh, or 
Linux applications. The exact steps for printing a document may vary 
depending on the application you use.

•Your Printing Preferences window that appears in this user’s guide 
may differ depending on the machine in use. However, the 
composition of the Printing Preferences window is similar. Check 
the operating system(s) that are compatible with your machine. 
Refer to the OS compatibility section of Printer Specifications. 
(See "System requirements" on page 23.)

•When you select an option in Printing Preferences, you may see a 
warning mark, , or . An exclamation mark ( ) means you 
can select that certain option but it is not recommended, and ( )
mark means you cannot select that option due to the machine’s 
settings or environment.

The following procedure describes the general steps required for printing 
from various Windows applications. 

•Macintosh basic printing. (See "Macintosh printing" on page 48.)
•Linux basic printing. (See "Linux printing" on page 49.)

The following Printing Preferences window is for Notepad in Windows XP. 
Your Printing Preferences window may differ, depending on your 
operating system or the application you are using. 
1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. 
3. Select your machine from the Select Printer list.

You can select the basic print settings, including the number of copies 
and the print range from within the Print window. 

To take advantage of the printer features provided by your printer 
driver, click Properties or Preferences in the application’s Print
window to change the print setting. (See "Opening printing 
preferences" on page 44.)

4. To start the print job, click OK or Print in the Print window.
If you are using Windows Internet Explorer, the Samsung AnyWeb 
Print too will save your time for screen-captured images or printing 
the image. Click Start > All programs > Samsung Printers > 
Samsung AnyWeb Print to link the website where the tool is 
available for the download.
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Canceling a print job
If the print job is waiting in a print queue or print spooler, cancel the job as 
follows:
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

•For Windows XP/2003, select Printer and Faxes.
•For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
•For Windows 7, select Control Panel > Hardware and Sound >

Devices and Printers.
•For Windows Server 2008 R2, select Control Panel > Hardware >

Devices and Printers.
3. For Windows 2000, XP, 2003, 2008 and Vista, double-click your 

machine.
For Windows 7 and Windows Server 2008 R2, right click your printer 
icon > context menus > See what’s printing.

If See what’s printing item has a  mark, you can select other 
printer drivers connected with selected printer.

4. From the Document menu, select Cancel.
You can also access this window by simply double-clicking the 
machine icon ( ) in the Windows task bar. 

You can also cancel the current job by pressing  on the control 
panel.

OPENING PRINTING PREFERENCES
You can preview the settings you selected on the upper right of the Printing
Preferences.
1. Open the document you want to print.
2. Select Print from the file menu. The Print window appears. 
3. Select your machine from the Select Printer.
4. Click Properties or Preferences.

Using a favorite setting
The Presets option, which is visible on each of the preferences tab except 
for the Samsung tab, allows you to save the current preferences for future 
use. 
To save a Presets item:
1. Change the settings as needed on each tab. 
2. Enter a name for the item in the Presets input box.

3. Click Add. When you save Presets, all current driver settings are saved.
If you click Add, the Add button changes to the Update button. Select more 
options and click Update, settings will be added to the Presets you made.
To use a saved setting, select it from the Presets drop-down list. The 
machine is now set to print according to the settings you have selected.
To delete saved settings, select it from the Presets drop-down list and click 
Delete.
You can also restore the printer driver’s default settings by selecting Default
Preset from the Presets drop-down list.

USING HELP
Click the question mark on the upper-right corner of the window and click on 
the topic you want to know about. Then a pop up window appears with 
information about that option's feature which is provided from the driver. 

If you want to search information via a keyword, click the Samsung tab in 
the Printing Preferences window, and enter a keyword in the input line of 
the Help option. To get information about supplies, driver updates or 
registration and so on, click appropriate buttons.

USING SPECIAL PRINT FEATURES
Special print features include:
• "Printing multiple pages on one sheet of paper" on page 45.
• "Printing posters" on page 45.
• "Printing booklets (Manual)" on page 45.
• "Printing on both sides of the paper (Manual)" on page 45.
• "Change percentage of your document" on page 46.
• "Fitting your document to a selected paper size" on page 46.
• "Using watermarks" on page 46.
• "Using overlays" on page 46.
• "Print quality options" on page 47.
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Printing multiple pages on one sheet of paper
You can select the number of pages to print on a single sheet of paper. To 
print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one 
sheet. 
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 44.)

2. Click the Basic tab, select Multiple Pages Per Side in the Type
drop-down list.

3. Select the number of pages you want to print per sheet (2, 4, 6, 9, or 16) 
in the Pages per Side drop-down list.

4. Select the page order from the Page Order drop-down list, if necessary. 
5. Check Print Page Border to print a border around each page on the 

sheet.
6. Click the Paper tab, select the Size, Source, and Type.
7. Click OK or Print until you exit the Print window.

Printing posters
This feature allows you to print a single-page document onto 4, 9, or 16 
sheets of paper, for the purpose of pasting the sheets together to form one 
poster-size document.

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 44.)

2. Click the Basic tab, select Poster Printing in the Type drop-down list.
3. Select the page layout you want.

Available layouts:
•Poster 2x2: Document will be enlarged and be divided into 4 pages.
•Poster 3x3: Document will be enlarged and be divided into 9 pages.
•Poster 4x4: Document will be enlarged and be divided into 16 pages.

4. Select the Poster Overlap value. Specify Poster Overlap in millimeters 
or inches by selecting the radio button on the upper right of Basic tab to 
make it easier to paste the sheets together.

5. Click the Paper tab, select the Size, Source, and Type.
6. Click OK or Print until you exit the Print window.
7. You can complete the poster by pasting the sheets together.

Printing booklets (Manual)
This feature prints your document on both sides of a paper and arranges the 
pages so that the paper can be folded in half after printing to produce a 
booklet.

If you want to make a booklet, you need to print on Letter, Legal, A4, 

US Folio, or Oficio sized print media. 

8 9

1. To change the print settings from your software application, access the 
Printing Preferences. (See "Opening printing preferences" on 
page 44.)

2. Click the Basic tab, select Booklet Printing from the Type drop-down 
list.

3. Click the Paper tab, select the Size, Source, and Type.
The Booklet Printing option is not available for all paper sizes. In 
order to find out the available paper size for this feature, select the 
available paper size in the Size option on the Paper tab.
If you select an unavailable paper size, this option can be 
automatically canceled. Select only available paper. (paper without 

 or  mark).
4. Click OK or Print until you exit the Print window.
5. After printing, fold and staple the pages.

Printing on both sides of the paper (Manual)
You can print on both sides of a paper (duplex). Before printing, decide how 
you want your document oriented. You can use this feature with Letter, 
Legal, A4, US Folio, or Oficio sized paper. (See "Print media specifications" 
on page 70.)

We recommend not to print on both sides of special media, such as 
labels, envelopes  or thick paper. It may cause a paper jam or damage 
the machine. 

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 44.)

2. Click the Advanced tab.
3. From the Double-Sided Printing (Manual) section, select the binding 

option you want.   
•None
•Long Edge: This option is the conventional layout used in 

bookbinding.

•Short Edge: This option is the conventional layout used in calendars.

4. Click the Paper tab, select the Size, Source, and Type.
5. Click OK or Print until you exit the Print window

If your machine does not have a duplex unit, you should complete the 
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printing job manually. The machine prints every other page of the 
document first. After that, a message appears on your computer. 
Follow the on-screen instructions to complete the printing job.

Change percentage of your document
You can change the size of a document to appear larger or smaller on the 
printed page by typing in a percentage you want.

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 44.)

2. Click the Paper tab.
3. Enter the scaling rate in the Percentage input box.

You can also click the up/down arrows to select the scaling rate. 
4. Select the Size, Source, and Type in Paper Options.
5. Click OK or Print until you exit the Print window

Fitting your document to a selected paper size
This feature allows you to scale your print job to any selected paper size 
regardless of the document size. This can be useful when you want to 
check fine details on a small document. 

A

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 44.)

2. Click the Paper tab.
3. Select the paper size you want from the Fit to Page.
4. Select the Size, Source, and Type in Paper Options.
5. Click OK or Print until you exit the Print window

Using watermarks
The watermark option allows you to print text over an existing document. 
For example, you use it when you want to have large gray letters reading 
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all 
pages of a document. 

There are several predefined watermarks that come with the machine. They 
can be modified, or you can add new ones to the list. 

Using an existing watermark
1.To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 44.)

2.Click the Advanced tab, and select the desired watermark from the 
Watermark drop-down list. You will see the selected watermark in 
the preview image. 

3.Click OK or Print until you exit the print window. 

Creating a watermark
1.To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 44.)

2.From the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3.Enter a text message in the Watermark Message box. You can enter 
up to 256 characters. The message displays in the preview window.
When the First Page Only box is checked, the watermark prints on 
the first page only.

4.Select watermark options. 
You can select the font name, style, size, and shade from the Font 
Attributes section, as well as set the angle of the watermark from 
the Message Angle section. 

5.Click Add to add a new watermark to the Current Watermarks list.   
6.When you have finished, click OK or Print until you exit the Print

window.
To stop printing the watermark, select None from the Watermark
drop-down list. 

Editing a watermark
1.To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 44.)

2.Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3.Select the watermark you want to edit from the Current Watermarks
list and change the watermark message and options. 

4.Click Update to save the changes.
5.Click OK or Print until you exit the Print window. 

Deleting a watermark
1.To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 44.)

2. Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3.Select the watermark you want to delete from the Current 
Watermarks list and click Delete.

4.Click OK or Print until you exit the Print window.

Using overlays
An overlay is content you store on your hard disk drive that can be 
superimposed over any document you print. An overlay is often used to take 
the place of letterhead paper. Rather than using preprinted letterhead, you 
can create an overlay containing exactly the same information that is 
currently on your letterhead. To print a letter with your company’s 
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letterhead, you do not need to load preprinted letterhead paper in the 
machine, instead you can just print the letterhead overlay on your 
document.

Creating a new overlay
To use a page overlay, you must create a new page overlay file 
containing your content.
1.Create or open a document containing the content you want to use in 

a new page overlay. Position the items exactly where you want them 
to appear when they are added to the original.

2.To save the document as an overlay, access Printing Preferences.
(See "Opening printing preferences" on page 44.)

3.Click the Advanced tab, and select Edit from the Text drop-down list. 
The Edit Overlay window appears.

4.In the Edit Overlay window, click Create.
5.In the Save As window, type a name of up to eight characters in the 

File name box. Select the destination path, if necessary. (The 
default is C:\Formover.)

6.Click Save. The name appears on the Overlay List.
7.Click OK or Print until you exit the Print window.
8.The file is not printed. Instead, it is stored on your computer hard disk 

drive.
The overlay document size must match same as the document 
you print. Do not create an overlay with a watermark.

Using an overlay
After an overlay has been created, it is ready to be printed with your 
document. To print an overlay on your document:
1.Create or open the document you want to print.
2.To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 44.)

3.Click the Advanced tab. 
4.Select the desired overlay from the Text drop-down list. 
5.If the overlay file you want does not appear in the Text drop-down list, 

select Edit from the list and click Load. Select the overlay file you 
want to use. 
If you have stored the overlay file you want to use in an external 
source, you can also load the file when you access the Open
window. 
After you select the file, click Open. The file appears in the Overlay 
List box and is available for printing. Select the overlay from the 
Overlay List box. 

6. If necessary, check Confirm Page Overlay When Printing box. If 
this box is checked, a message window appears each time you 
submit a document for printing, asking you to confirm that you wish 
to print an overlay over your document. 
If this box is not checked and an overlay has been selected, the 
overlay automatically prints with your document. 

7.Click OK or Print until you exit the Print window. 
The selected overlay prints over your document. 

The resolution of the overlay document must match the resolution 
of the original print job.

Deleting an overlay
You can delete page overlays that you no longer use. 
1.In the Printing Preferences window, click the Advanced tab. 
2.Select Edit in the Overlay drop down list. 
3.Select the overlay you want to delete from the Overlay List box. 
4.Click Delete.
5.When the confirmation message window appears, click Yes.
6.Click OK or Print until you exit the Print window.

Print quality options
Use the following Graphics options to adjust the print quality for your 
specific printing needs.
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 44.)

2. Click the Graphics tab.
•The options you can select may vary depending on your printer 

model. 
•Refer to the help for each option’s information provided from the 

Printing Preferences.
•Font/Text: Select Darken Text to print text darker than on a normal 

document. Use All Text Black to print solid black, regardless of the 
color it appears on the screen.

•Graphic Controller: Fine Edge allows you to emphasize edges of 
texts and fine lines for improving readability.

•Toner Save: Selecting this option extends the life of your toner 
cartridge and reduces your cost per page without a significant 
reduction in print quality.
-Printer Setting: If you select this option, this feature is determined 

by the setting you’ve made from the machine (For some models, 
you cannot change the setting from the machine. In this case, the 
default setting is Off). 

-On: Select this option to allow the printer to use less toner on each 
page.

-Off:Select this option if you do not want to save toner when printing 
a document.

•Darkness: The option adjusts the toner density on print outputs. The 
values are Normal, Light, and Dark.

3. Click OK or Print until you exit the Print window.

CHANGING THE DEFAULT PRINT SETTINGS
Most Windows applications will override settings you specify in the 
printer driver. Change all print settings available in the software 
application first, and change any remaining settings using the printer 
driver. 

1. Click the Windows Start menu. 
2. For Windows 2000, select Settings > Printers.

•For Windows XP/2003, select Printers and Faxes.
•For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
•For Windows 7, select Control Panel > Hardware and Sound >

Devices and Printers.
•For Windows Server 2008 R2, select Control Panel > Hardware >
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Devices and Printers.
3. Right-click your machine.
4. For Windows XP/2003/2008/Vista, press Printing Preferences.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printing preferences.

If Printing preferences item has a  mark, you can select other 
printer drivers connected with the selected printer.

5. Change the settings on each tab. 
6. Click OK.

If you want to change the settings for each print job, change it in 
Printing Preferences.

SETTING YOUR MACHINE AS A DEFAULT 
MACHINE
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printers and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
• For Windows 7, select Control Panel > Hardware and Sound >

Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware >

Devices and Printers.
3. Select your machine.
4. Right-click your machine and select Set as Default Printer.

For Windows 7 and Windows Server 2008 R2
If Set as default printer item has a  mark, you can select other 
printer drivers connected with the selected printer.

PRINTING TO A FILE (PRN)
You will sometimes need to save the print data as a file. 
To save a print job as a file:
1. Check the Print to file box at the Print window.

2. Click Print.
3. Type in the destination path and the file name, and then click OK.

For example c:\Temp\file name.
If you type in only the file name, the file is automatically saved in 

My Documents.

MACINTOSH PRINTING
This chapter explains how to print using a Macintosh. You need to set the 
print environment before printing. 
• USB connected (See "Macintosh" on page 25.)

Printing a document
When you print with a Macintosh, you need to check the printer driver 
setting in each application you use. Follow the steps below to print from a 
Macintosh:
1. Open an application and select the file you want to print.
2. Open the File menu and click Page Setup (Document Setup in some 

applications).
3. Choose your paper size, orientation, scaling, other options, and make 

sure that your machine is selected. Click OK.

4. Open the File menu and click Print.
5. Choose the number of copies you want and indicate which pages you 

want to print. 
6. Click Print.

Changing printer settings
You can use advanced printing features provided by your machine.
Open an application and select Print from the File menu. The machine 
name, which appears in the printer properties window may differ depending 
on the machine in use. Except for the name, the composition of the printer 
properties pane is similar to the following.

•The setting options may differ depending on models and Macintosh 
OS versions.

•The following panes may differ, depending on your operating system 
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or the application you are using.
The following pane is the first pane you will see when you open the printer 
properties pane. Select other advanced features from the drop down list. 

Layout
The Layout dialog provides options to adjust how the document 
appears on the printed page. You can print multiple pages on one sheet 
of paper. Select Layout from the drop-down list under Orientation to 
access the following features.
•Pages per Sheet: This option determines how many pages to be 

printed on one page. (See "Printing multiple pages on one sheet of 
paper" on page 49.)

•Layout Direction: This option allows you to select the printing 
direction on a page similar to the examples on UI.

•Border: This option allows you to print a border around each page on 
the sheet.

•Reverse Page Orientation: This option allows you to rotate paper 180 
degrees.

Graphics
The Graphics dialog provides options for selecting Resolution. Select 
Graphics from the drop-down list under Orientation to access the 
graphic features.
•Resolution (Quality): This option allows you to select the printing 

resolution. The higher the setting, the sharper the clarity of printed 
characters and graphics. A higher setting will also increase the time 
it takes to print a document.

•Darkness: This option allows you to enhance the darkness of the 
printouts. The available options are Normal, Light, and Dark.

Printer Features
Set paper type to correspond to the paper loaded in the tray from which 
you want to print. This will let you get the best quality printout. If you load 
a different type of print material, select the corresponding paper type.

Printer Settings
The Printer Settings dialog provides Toner Save Mode, Reprint When 
Jammed, and Power Save options. Select Printer Settings from the 
drop-down list under Orientation to access the following features:
•Toner Save Mode: Selecting this option extends the life of your toner 

cartridge and reduces your cost per page without a significant 
reduction in print quality.
-Printer Setting: If you select this option, this feature is determined 

by the setting you’ve made from the machine (For some models, 
you cannot change the setting from the machine. In this case, the 
default setting is Off). 

-On: Select this option to allow the printer to use less toner on each 
page.

-Off: Set this option if you do not need to save toner when printing a 
document.

Printing multiple pages on one sheet of paper
You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft pages.
1. Open an application, and select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. In the Pages 

per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3. Select the other options you want to use.
4. Click Print, then the machine prints the selected the number of pages 

you want to print on one sheet of paper.

LINUX PRINTING
Printing from applications
There are several Linux applications that allow you to print using the 
Common UNIX Printing System (CUPS). You can print using any of these 
applications.
1. Open an application, and select Print from the File menu.
2. Select Print directly using LPR.
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3. From the LPR GUI window, select the model name of your machine from 
the printer list and click Properties.

4. Change the print job properties using the following four tabs displayed at 
the top of the window.

•General: This option allows you to change the paper size, the paper 
type, and the orientation of the documents. It enables the duplex 
feature, adds start and end banners, and changes the number of 
pages per sheet.

•Text: This option allows you to specify the page margins and set the 
text options, such as spacing or columns.

•Graphics: This option allows you to set image options that are used 
when printing images/files, such as color options, image size, or 
image position.

•Advanced: This option allows you to set the print resolution, paper 
source and special print features.

If an option is grayed out, it means that the grayed out option is not 
supported by your machine.

5. Click Apply to apply the changes and close the Properties window.
6. Click OK in the LPR GUI window to start printing.
7. The Printing window appears, allowing you to monitor the status of your 

print job.
To abort the current job, click Cancel.

Printing files
You can print many different types of files on your machine using the 
standard CUPS way, directly from the command line interface. The CUPS 
LPR utility allows you to do that. But the drivers package replaces the 
standard LPR tool by a much more user-friendly LPR GUI program.
To print any document file:
1. Type lpr <file_name> from the Linux shell command line and press 

Enter. The LPR GUI window appears.
When you type only lpr and press Enter, the Select file(s) to print
window appears first. Just select any files you want to print and click 
Open.

2. From the LPR GUI window, select your machine from the list, and 
change the print job properties.

3. Click OK to start printing.

Configuring printer properties
Using the Printer Properties window provided by the Printers
configuration, you can change the various properties for your printer.
1. Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2. Select your machine from the available printers list and click Properties.
3. The Printer Properties window opens.

The following five tabs display at the top of the window:
•General: This option allows you to change the printer location and 

name. The name entered in this tab displays on the printer list in 
Printers configuration.

•Connection: This option allows you to view or select another port. If 
you change the machine port from USB to parallel or vice versa 
while in use, you must re-configure the machine port in this tab.

•Driver: Allows you to view or select another printer driver. By clicking 
Options, you can set the default device options.

•Jobs: This option shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed jobs check 
box to see previous jobs on the job list.

•Classes: This option shows the class that your machine is in. Click 
Add to Class to add your machine to a specific class or click 
Remove from Class to remove the machine from the selected 
class.

4. Click OK to apply the changes and close the Printer Properties
window.
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7.management tools
This chapter introduces management tools provided to help you make full use of your machine. 
This chapter includes:
• Introducing useful management tools
• Using the Smart Panel program

• Using the Unified Linux Driver Configurator

INTRODUCING USEFUL MANAGEMENT TOOLS
The programs below help you to use your machine conveniently.
• "Using the Smart Panel program" on page 51.
• "Using the Unified Linux Driver Configurator" on page 52.
• "Using SyncThru™ Web Service" on page 53

USING THE SMART PANEL PROGRAM
Smart Panel is a program that monitors and informs you of the machine 
status, and allows you to customize the machine’s driver settings. For 
Windows and Macintosh, Smart Panel is installed automatically when you 
install the machine software. For Linux, you can download the Smart Panel 
from the Samsung website (See "Installing the SmartPanel" on page 26).

To use this program, your computer has to meet the following system 
requirements:
•Windows. Check that your computers CPU, RAM, and HDD meet or 

exceed spec. (See "System requirements" on page 23.)
•Mac OS X 10.3 or higher. Check that your computers CPU, RAM, 

and HDD meet or exceed spec. (See "System requirements" on 
page 23.)

•Linux. Check that your computers CPU, RAM, and HDD meet or 
exceed spec.
e. (See "System requirements" on page 23.)

•Internet Explorer version 5.0 or higher for flash animation in HTML 
Help.

If you need to know the exact model number of your machine, you can 
check the supplied software CD.

Understanding Smart Panel
If an error occurs while printing, you can check the error from the Smart 
Panel.
You can also launch Smart Panel manually. Double-click the Smart Panel 
icon on the Windows task bar (in Windows), or Notification Area (in Linux). 

Windows Double-click this icon in Windows.

Linux Click this icon in Linux.

Or, if you are a Windows user, you can launch it from the Start menu, select 
Programs or All Programs > Samsung Printers > your printer driver 
name > Smart Panel.

• If you have already installed more than one Samsung machine, 
first select the correct machine model you want in order to access 
the corresponding Smart Panel.

Right-click (in Windows or Linux) the Smart Panel icon and select 
your machine.

• The Smart Panel window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in 
use.

In  case of  Mac OS 10.3
1. Click ‘Print & Fax’ in System Preferences
2. Click ‘Set up Printers...’.
3. Select printer in list and double click it.
4. Click ‘Utility’.

In  case of  Mac OS 10.4
1. Click ‘Print & Fax’ in System Preferences
2. Select printer in list and click ‘Printer Queue…’.
3. Click ‘Utility’.

In  case of  Mac OS 10.5
1. Click ‘Print & Fax’ in System Preferences
2. Select printer in list and click ‘Open Printer Queue...’.
3. Click ‘Utility’.

In  case of  Mac OS 10.6
1. Click ‘Print & Fax’ in System Preferences
2. Select printer in list and click ‘Open Printer Queue...’.
3. Click ‘Printer Setup’.
4. Click ‘Utility ’ tab.
5. Click ‘Open Printer Utility’.

The Smart Panel program displays the current status of the machine, the 
level of toner remaining in the toner cartridge(s), and various other types of 
information. You can also change settings.
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Toner Level View the level of toner remaining in the toner 
cartridge(s). The machine and the number of toner 
cartridge(s) shown in the above window may differ 
depending on the machine in use. Some machines 
do not have this feature.

2 Buy Now Order replacement toner cartridge(s) online.

3

User’s Guide View the User’s Guide.
This button changes to Troubleshooting 
Guide when error occurs. You can directly 
open the troubleshooting section in the 
user’s guide. 

4

Printer
Setting

Configure various machine settings in the Printer 
Settings Utility window. Some machines do not 
have this feature.

If you connect your machine to a network, 
the SyncThru™ Web Service window 
appears instead of the Printer Settings Utility 
window.

5

Driver Setting Set all of the machine options you need in the 
Printer Preferenceswindow. This feature is 
available only for Windows (See Opening printing 
preferences).
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Opening the Troubleshooting Guide
Find solutions for problems by using the Troubleshooting Guide.
Right-click (in Windows or Linux) the Smart Panel icon and select 
Troubleshooting Guide.

Changing the Smart Panel Program Settings
Right-click (in Windows or Linux) the Smart Panel icon and select Options.
Select the settings you want from the Options window. 

USING THE UNIFIED LINUX DRIVER 
CONFIGURATOR
The Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. You need to install Unified Linux Driver to use Unified 
Driver Configurator (See "Installing the Unified Linux Driver" on page 26).
After the driver is installed on your Linux system, the Unified Driver 
Configurator icon will automatically be created on your desktop

Opening the Unified Driver Configurator
1. Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.

2. Click each button on the left to switch to the corresponding configuration 
window.  

1 Printers 
Configuration 

2 Ports 
Configuration 

 To use the on screen help, click Help.

3. After changing the configurations, click Exit to close the Unified Driver 
Configurator.

Printers configuration window
Printers configuration has the two tabs: Printers and Classes.

Printers tab
View the current system’s printer configuration by clicking on the 
machine icon button on the left side of the Unified Driver Configurator 
window.

1 Switches to Printers configuration.

2 Shows all of the installed machine.

3 Shows the status, model name and URI of your machine.

The printer control buttons are, as follows:
•Refresh: Renews the available machines list.
•Add Printer: Allows you to add a new machines.
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•Remove Printer: Removes the selected machine.
•Set as Default: Sets the current selected machine as a default 

machine.
•Stop/Start: Stops/starts the machine.
•Test: Allows you to print a test page to ensure the machine is working 

properly.
•Properties: Allows you to view and change the printer properties. 

Classes tab
The Classes tab shows a list of available machine classes.

1 Shows all of the machine classes.

2
Shows the status of the class and the number of machines in the 
class.

•Refresh: Renews the classes list.
•Add Class: Allows you to add a new machine class.
•Remove Class: Removes the selected machine class.

Ports configuration
In this window, you can view the list of available ports, check the status of 
each port, and release a port that is stalled in a busy state when its owner 
has terminated the job for any reason.

1 Switches to Ports configuration.

2 Shows all of the available ports.

3 Shows the port type, device connected to the port, and status.

• Refresh: Renews the available ports list.
• Release port: Releases the selected port. 

USING SYNCTHRU™ WEB SERVICE
Internet Explorer 6.0 or higher is the minimum requirement for 
SyncThru™ Web Service.

If you have connected your machine to a network and set up TCP/IP 
network parameters correctly, you can manage the machine via SyncThru™ 
Web Service, an embedded web server. Use SyncThru™ Web Service to:
• View the machine’s device information and check its current status.
• Change TCP/IP parameters and set up other network parameters.
• Change printer preference.
• Set the email notifications advising of the machine’s status.
• Get support for using the machine.

To access SyncThru™ Web Service
1. Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.

Logging into SyncThru™ Web Service
Before configuring options in SyncThru™ Web Service, you need to 
log-in as an administrator. You can still use SyncThru™ Web Service 
without logging in but you won’t have access to Settings tab and 
Security tab. 
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1. Click Login on the upper right of the SyncThru™ Web Service 
website.
A log-in page appears. 

2. Type in the ID and Password then click Login.
If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
• ID: admin
• Password: sec00000

SyncThru™ Web Service overview

Some tabs may not appear depending on your model.

Information tab
This tab gives you general information about your machine. You can 
check things, such as remaining amount of toner. You can also print 
reports such as an error report and so on. 
• Active Alerts: This item allows you to check the alerts occurred in 

the machine and their severity.
• Supplies: This item allows you to check how many pages are 

printed and amount of toner left in the cartridge.
• Usage Counters: This item allows you to check the usage count by 

print types: simplex, duplex
• Current Settings: This item allows you to check the machine and 

network information. 
• Print information: This item allows you to print reports such as 

system related reports, e-mail address and font reports.

Settings tab
This tab allows you to set configurations provided by your machine and 
network. You need to log-in as an administrator to view this tab. 
• Machine Settings tab: This tab allows you to set options provided 

by your machine.
- System: You can set settings related to your machine.
- Printer: You can set settings related to printing jobs. 

• Network Settings tab: This tab allows you to view and change the 
network environment. You can set things, such as TCP/IP, network 
protocols and so on. 
- SNMP: You can exchange of management information between 

network devices using SNMP

Security tab
This tab allows you to set system and network security information. You 
need to log-in as an administrator to view this tab.
• System Security: You can set the system administrator’s 

information and also enable or disable machine features
• Network Security: You can set settings for SNMPv3, IPv4/IPv6 

filtering, and MAC filtering. 

Maintenance tab
This tab allows you to maintain your machine by upgrading firmware and 
setting contact information for sending emails. You can also connect to 
Samsung website or download drivers by selecting the Link menu.
• Firmware Upgrade: You can upgrade your machine’s firmware.
• Contact Information: You can view the contact information.
• Link: You can view the links to useful sites where you can download 

or check information.

Setting the system administrator information
Set the system administrator information. This setting is necessary for using 
the e-mail notification option.
1. Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.
3. Click Login on the upper right of the SyncThru™ Web Service website.

A log-in page appears. 
4. Type in the ID and Password then click Login.

If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
• ID: admin
• Password: sec00000

5. From the Security tab, select System Security > System 
Administrator

6. Enter the name of the administrator, phone number, location and E-mail 
address. 

7. Click Apply.
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8.maintenance
This chapter provides information about maintaining your machine and the toner cartridge.
This chapter includes:
• Printing a machine report
• Cleaning a machine

• Storing the toner cartridge
• Tips for moving & storing your machine

PRINTING A MACHINE REPORT
You can print a configuration page to view current printer settings, or to help 
troubleshoot printer problems. 
(See "(WPS) button" on page 21.)

CLEANING A MACHINE
If printing quality problems occur or if you use your machine in a dusty 
environment, you need to clean your machine regularly to keep the the most 
optimum print quality.

•Cleaning the outside of the machine with cleaning materials 
containing large amounts of alcohol, solvent, or other strong 
substances can discolor or distort the cabinet. 

•If your machine or the surrounding area is contaminated with toner, 
we recommend that you use a cloth or tissue dampened with water 
to clean it. If you use a vacuum cleaner, toner blows in the air and 
might be harmful if inhaled.

Cleaning the outside
Clean the machine cabinet with a soft, lint-free cloth. Dampen the cloth 
slightly with water, but be careful not to let any water drip onto or into the 
machine.

Cleaning the inside
During the printing process, paper dust, toner, and dust particles in the air 
can accumulate inside the machine. This buildup can cause print quality 
problems, such as toner specks or smearing. Cleaning the inside of the 
machine clears and reduces these problems.

1. Turn the machine off and unplug the power cord. Wait for the machine to 
cool down.

2. Open the top cover and pull the toner cartridge out. Set it on a clean flat 
surface.

•To prevent damage to the toner cartridge, do not expose it to light 
for more than few minutes. Cover it with a piece of paper, if 
necessary.

•Do not touch the green surface of the drum located in the toner 
cartridge or imaging unit. Use the handle on the cartridge to 
avoid touching this area.

3. With a dry, lint-free cloth, wipe away any dust and spilled toner from the 
toner cartridge area.

While cleaning the inside of the machine, be careful not to damage 
the transfer roller or any other inside parts. Do not use solvents 
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such as benzene or thinner to clean. Printing quality problems can 
occur and cause damage to the machine.

4. Reinsert the toner cartridge and close the top cover.
5. Plug in the power cord and turn the machine on.

STORING THE TONER CARTRIDGE
Toner cartridges contain components that are sensitive to light, 
temperature, and humidity. Samsung suggests users follow the 
recommendations below to ensure the optimum performance, highest 
quality, and longest life from your new Samsung toner cartridge.
Store this cartridge in the same environment as the printer it will be used in; 
this should be in controlled office temperature and humidity conditions. The 
toner cartridge should remain in its original, unopened package until 
installation – If original packaging is not available, cover the top opening of 
the cartridge with paper and store it in a dark cabinet.
Opening the cartridge package prior to use dramatically shortens its useful 
shelf and operating life. Do not store on the floor. If the toner cartridge is 
removed from the printer, always store the cartridge according to the 
following guidelines:
• Inside the protective bag from the original package. 
• Store lying flat (not standing on end) with the same side facing up as if it 

was installed in the machine.
• Do not store consumable in any of the following conditions:

-Temperature greater than 40°C (104°F).
-Humidity range less than 20% and not greater than 80%.
-An environment with extreme changes in humidity or temperature.
-Direct sunlight or room light.
-Dusty places.
-A car for a long period of time.
-An environment where corrosive gases are present.
-An environment with salty air.

Handling instructions
• Do not touch the surface of the photoconductive drum in the cartridge.
• Do not expose the cartridge to unnecessary vibrations or shock.
• Never manually rotate the drum, especially in the reverse direction; this 

can cause internal damage and toner spillage.

Use of non-Samsung and refilled toner cartridge
Samsung Electronics does not recommend or approve the use of 
non-Samsung brand toner cartridges in your printer including generic, store 
brand, refilled, or remanufactured toner cartridges.

Samsung’s printer warranty does not cover damage to the machine 
caused by the use of a refilled, remanufactured, or non-Samsung 
brand toner cartridge.

Estimated cartridge life
Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print yield may vary 
depending on the print density of the pages you print on, operating 
environment, printing interval, media type, and/or media size. For example, 
if you print a lot of graphics, the consumption of the toner is high and you 
may need to change the cartridge more often.

TIPS FOR MOVING & STORING YOUR MACHINE
When moving the machine, do not tilt or turn it upside down. Otherwise, the 
inside of the machine may be contaminated by toner, which can cause 
damage to the machine or reduce print quality.
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9.troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
This chapter includes:
• Redistributing toner
• Tips for avoiding paper jams

• Clearing paper jams
• Solving other problems

REDISTRIBUTING TONER
When the toner cartridge is near the end of its life:
• White streaks or light printing occurs. 
• The  LED blinks red. 
If this happens, you can temporarily improve print quality by redistributing 
the remaining toner in the cartridge. In some cases, white streaks or light 
printing will still occur even after you have redistributed the toner.
1. Open the top cover.

When you open the top cover, make sure that the output tray is 
closed.

2. Pull the toner cartridge out.

3. Thoroughly roll the cartridge five or six times to distribute the toner 
evenly inside the cartridge.

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

Do not touch the drum in the the toner cartridge or imaging unit. 
Use the handle on the cartridge to avoid touching this area. 

4. Hold the toner cartridge by the handle and slowly insert the cartridge into 
the opening in the machine. 

The tabs on the sides of the cartridge and corresponding grooves within 
the machine will guide the cartridge into the correct position until it locks 
into place completely.

5. Close the top cover. Ensure that the cover is securely closed. 

TIPS FOR AVOIDING PAPER JAMS
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, refer to the guidelines below:
• Ensure that the adjustable guides are positioned correctly. (See 

"Loading paper in the tray" on page 39.)
• Do not overload the tray. Ensure that the paper level is below the paper 

capacity mark on the inside of the tray.
• Do not remove paper from the tray while your machine is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media.
• Ensure that the recommended side of the print media is facing the right 

side. (See "Loading paper in the tray" on page 39.)

CLEARING PAPER JAMS
If a paper jam occurs, the LED on the control panel lights orange. Find and 
remove the jammed paper. 
To resume printing after clearing paper jams, you must open and close the 
top cover.

To avoid tearing the paper, pull the jammed paper out slowly and 
carefully. Follow the instructions in the following sections to clear the 
jam. 
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In tray 
Click this link to open an animation about clearing a jam.

1. If the output tray is opened, close the output tray first. 
2. Open and close the top cover. The jammed paper is automatically 

ejected from the machine. Make sure to open the output tray before 
paper ejects from the machine. 
If the paper does not eject, go to the next step.

3. Remove the jammed paper by gently pulling it straight out.

If the paper does not move when you pull, or if you do not see the paper 
in this area, check inside the machine. (See "Inside the machine" on 
page 58.)

Inside the machine
Click this link to open an animation about clearing a jam.

The fuser area is hot. Be careful when removing paper from this area 
to prevent getting your fingers burnt.

1. If the output tray is opened, close the output tray first. 
2. Open and close the top cover. The jammed paper is automatically 

ejected from the machine. Make sure to open the output tray before 
paper ejects from the machine. 
If the paper does not eject, go to the next step.

3. Close the output tray and open the top cover. 
4. Open the fuser unit cover.

.

5. Remove the jammed paper by gently pulling it straight out.

If you do not see the jammed paper, go to the next step.
6. Pull the toner cartridge out.

7. Remove the jammed paper by gently pulling it straight out.
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8. Insert the toner cartridge back into the machine.

9. Close the fuser unit cover. 
10. Close the top cover and open the output tray. Printing automatically 

resumes.

SOLVING OTHER PROBLEMS
The following chart lists some trouble conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the problem is 
corrected. If the problem persists, contact a service representative.
Other problems include:
• See "Power problems" on page 59.
• See "Paper feeding problems" on page 60.
• See "Printing problems" on page 60.
• See "Printing quality problems" on page 62.
• See "Common Windows problems" on page 64.
• See "Common Linux problems" on page 64.
• See "Common Macintosh problems" on page 65.

Power problems
Click this link to open an animation about solving power problems.

CONDITION SUGGESTED SOLUTIONS

The machine is 
not receiving 
power, 
or the connection 
cable between the 
computer and the 
machine is not 
connected 
properly.

• Plug in the power cord and press  (power) 
on the control panel.

• Disconnect the machine cable and reconnect 
it.
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Paper feeding problems
CONDITION SUGGESTED SOLUTIONS

Paper jams during 
printing.

Clear the paper jam. (See "Clearing paper jams" 
on page 57.)

Paper sticks 
together.

• Check the maximum paper capacity of the 
tray. (See "Print media specifications" on 
page 70.)

• Make sure that you are using the correct type 
of paper. (See "Print media specifications" on 
page 70.)

• Remove paper from the tray and flex or fan 
the paper.

• Humid conditions may cause some paper to 
stick together, replace with a new stack.

Multiple sheets of 
paper do not feed.

Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

Paper does not feed 
into the machine.

• Remove any obstructions from inside the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine. (See "Print media specifications" on 
page 70.)

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, use the manual feeder.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine. (See "Print media 
specifications" on page 70.)

• There may be debris inside the machine. 
Open the top cover and remove any debris.

Transparencies stick 
together in the paper 
exit.

Use only transparencies specifically designed 
for laser printers. Remove each transparency as 
it exits from the machine.

Envelopes skew or 
fail to feed correctly.

Ensure that the paper guides are against both 
sides of the envelopes.

Printing problems

CONDITION POSSIBLE
CAUSE SUGGESTED SOLUTIONS

The machine 
does not print.

The machine is 
not receiving 
power.

Check the power cord 
connections.

The machine is 
not selected as 
the default 
machine.

Select your machine as your 
default machine in your Windows.

Check the machine for the following:
• The top cover is not closed. Close the top cover.
• Paper is jammed. Clear the paper jam. (See 

"Clearing paper jams" on page 57.)
• No paper is loaded. Load paper. (See "Loading 

paper in the tray" on page 39.)
• The toner cartridge is not installed. Install the toner 

cartridge.
If a system error occurs, contact a service 
representative.

The connection 
cable between 
the computer and 
the machine is 
not connected 
properly.

Disconnect the machine cable and 
reconnect it.

The connection 
cable between 
the computer and 
the machine is 
defective.

If possible, attach the cable to 
another computer that is working 
properly and print a job. You can 
also try using a different machine 
cable.

The port setting 
is incorrect.

Check the Windows printer 
settings to make sure that the print 
job is sent to the correct port. If the 
computer has more than one port, 
make sure that the machine is 
attached to the correct one.

The machine 
may be 
configured 
incorrectly.

Check the Printing Preferences
to ensure that all of the print 
settings are correct. (See 
"Opening printing preferences" on 
page 44.)

The printer driver 
may be 
incorrectly
installed.

Repair the machine software (See 
"Installing USB connected 
machine’s driver" on page 24).

The machine is 
malfunctioning.

• Check the LEDs on the control 
panel to see if the machine is 
indicating a system error. If the 
error cannot be cleared, contact 
a service representative.

• Checking an error message is 
also possible from the Smart 
Panel on your computer.
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The machine 
does not print. 

The document 
size is so big that 
the hard disk 
space of the 
computer is 
insufficient to 
access the print 
job.

Allocate more hard disk space on 
your computer for spooling, and try 
printing.

The output tray is 
full.

It can hold up to 100 sheets of 
plain paper. Once the paper is 
removed from the output tray, the 
machine resumes printing.

The machine 
selects print 
materials from 
the wrong 
paper source.

The paper option 
that was selected 
in the Printing
Preferences
may be incorrect.

For many software applications, 
the paper source selection is 
found under the Paper tab within 
the Printing Preferences. Select 
the correct paper source. See the 
printer driver help screen. (See 
"Opening printing preferences" on 
page 44.)

A print job is 
extremely slow.

The job may be 
very complex.

Reduce the complexity of the page 
or try adjusting the print quality 
settings.

Half the page is 
blank.

The page 
orientation 
setting may be 
incorrect.

Change the page orientation in 
your application. See the printer 
driver help screen.

The paper size 
and the paper 
size settings do 
not match.

Ensure that the paper size in the 
printer driver settings matches the 
paper in the tray.
Or, ensure that the paper size in 
the printer driver settings matches 
the paper selection in the software 
application settings you use.

The machine 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The machine 
cable is loose or 
defective.

Disconnect the machine cable and 
reconnect. Try a print job that you 
have already printed successfully. 
If possible, attach the cable and 
the machine to another computer 
that you know works and try a print 
job. Finally, try a new machine 
cable.

The wrong 
printer driver was 
selected.

Check the application’s printer 
selection menu to ensure that your 
machine is selected.

The software 
application is 
malfunctioning.

Try printing a job from another 
application.

The operating 
system is 
malfunctioning.

Exit Windows and reboot the 
computer. Turn the machine off 
and back on again.

CONDITION POSSIBLE
CAUSE SUGGESTED SOLUTIONS

Pages print, but 
they are blank.

The toner 
cartridge is 
defective or out 
of toner.

Redistribute the toner, if 
necessary. 
If necessary, replace the toner 
cartridge.

The file may 
have blank 
pages.

Check the file to ensure that it 
does not contain blank pages.

Some parts, such 
as the controller 
or the board, 
may be 
defective.

Contact a service representative.

The machine 
does not print 
PDF files 
correctly. Some 
graphics, text, 
or illustrations 
are missing.

Incompatibility 
between the PDF 
file and the 
Acrobat
products.

Printing the PDF file as an image 
may enable the file to print. Turn 
on Print As Image from the 
Acrobat printing options. 

It will take longer to print 
when you print a PDF file as 
an image.

The print 
quality of 
photos is not 
good. Images 
are not clear.

The resolution of 
the photo is very 
low. 

Reduce the photo size. If you 
increase the photo size in the 
software application, the resolution 
will be reduced. 

Before printing, 
the machine 
emits vapor 
near the output 
tray.

Using damp 
paper can cause 
vapor during 
printing.

This is not a problem. Just keep 
printing.

The machine 
does not print 
special- sized 
paper, such as 
billing paper.

Paper size and 
paper size 
setting do not 
match.

Set the correct paper size in the 
Edit... in the Paper tab in the 
Printing Preferences. (See 
"Opening printing preferences" on 
page 44.)

CONDITION POSSIBLE
CAUSE SUGGESTED SOLUTIONS
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
there might be a reduction in print quality. See the table below to clear the 
problem. 

CONDITION SUGGESTED SOLUTIONS

Light or faded print • If a vertical white streak or faded area 
appears on the page, the toner supply is low. 
You may be able to temporarily extend the 
toner cartridge life. (See "Redistributing toner" 
on page 57.) If this does not improve the print 
quality, install a new toner cartridge.

• The paper may not meet paper specification; 
for example, the paper may be too moist or 
rough. (See "Print media specifications" on 
page 70.)

• If the entire page is light, the print resolution 
setting is too low or the toner save mode is 
on. Adjust the print resolution and turn the 
toner save mode off. See the help screen of 
the printer driver.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning. (See "Cleaning the inside" on 
page 55.)

Toner specks • The paper may not meet specification; for 
example, the paper may be too moist or 
rough. (See "Print media specifications" on 
page 70.)

• The transfer roller may be dirty. Clean the 
inside of your machine. Contact a service 
representative.

• The paper path may need cleaning. Contact a 
service representative.

Dropouts If faded areas, generally rounded, occur 
randomly on the page:
• A single sheet of paper may be defective. 

Try reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper. (See "Print
media specifications" on page 70.)

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go 
to Printing Preferences, click the Paper
tab, and set type to Thick. (See "Opening 
printing preferences" on page 44.)

• If these steps do not correct the problem, 
contact a service representative.

White Spots If white spots appear on the page:
• The paper is too rough and a lot of dirt from a 

paper falls to the inner devices within the 
machine, so the transfer roller may be dirty. 
Clean the inside of your machine. (See 
"Cleaning the inside" on page 55.)

• The paper path may need cleaning. (See 
"Cleaning the inside" on page 55.)

Vertical lines If black vertical streaks appear on the page:
• The surface (drum part) of the toner 

cartridge inside the machine has probably 
been scratched. Remove the toner cartridge 
and install a new one. (See "Replacing the 
toner cartridge" on page 66.)

If white vertical streaks appear on the page:
• The surface of the LSU part inside the 

machine may be dirty. (See "Cleaning the 
inside" on page 55.)

Black background If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper. (See "Print

media specifications" on page 70.)
• Check the environmental conditions: very 

dry conditions or a high level of humidity 
(higher than 80% RH) can increase the 
amount of background shading.

• Remove the old toner cartridge and, install a 
new one. (See "Replacing the toner 
cartridge" on page 66.)

Toner smear If toner smears on the page: 
• Clean the inside of the machine. (See 

"Cleaning the inside" on page 55.)
• Check the paper type and quality. (See "Print 

media specifications" on page 70.)
• Remove the toner cartridge and then, install 

a new one. (See "Replacing the toner 
cartridge" on page 66.)

Vertical repetitive 
defects

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The toner cartridge may be damaged. If you 

still have the same problem, remove the 
toner cartridge and, install a new one. (See 
"Replacing the toner cartridge" on page 66.)

• Parts of the machine may have toner on 
them. If the defects occur on the back of the 
page, the problem will likely correct itself 
after a few more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

CONDITION SUGGESTED SOLUTIONS
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Background 
scatter

A
Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing 

with a fresh ream of paper. Do not open 
packages of paper until necessary so that 
the paper does not absorb too much 
moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing 
over areas that have overlapping seams on 
the reverse side. Printing on seams can 
cause problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the 
print quality through your software 
application or in Printing Preferences. (See 
"Opening printing preferences" on page 44.)

Toner particles are 
around bold 
characters or 
pictures

The toner might not adhere properly to this type 
of paper.
• Change the printer option and try again. 

Go to the Printing Preferences, click the 
Paper tab, and set the paper type to 
Recycled.

Misformed 
characters

• If characters are improperly formed and 
producing hollow images, the paper stock 
may be too slick. Try different paper. (See 
"Print media specifications" on page 70.)

Page skew

A a B b CA a B b CA a B b CA a B b C cA a B b C c

• Ensure that the paper is loaded properly.
• Check the paper type and quality. (See "Print 

media specifications" on page 70.)
• Ensure that the guides are not too tight or too 

loose against the paper stack.

CONDITION SUGGESTED SOLUTIONS

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl. (See "Print media specifications" on 
page 70.)

• Turn the stack of paper over in the tray. Also 
try rotating the paper 180° in the tray.

Wrinkles or 
creases

• Ensure that the paper is loaded properly.
• Check the paper type and quality. (See "Print 

media specifications" on page 70.)
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray.

Back of printouts 
are dirty

Check for leaking toner. Clean the inside of the 
machine. (See "Cleaning the inside" on 
page 55.)

Solid Color or 
Black pages

A
• The toner cartridge may not be installed 

properly. Remove the cartridge and reinsert it.
• The toner cartridge may be defective. 

Remove the toner cartridge and install a new 
one. (See "Replacing the toner cartridge" on 
page 66.)

• The machine may require repair. Contact a 
service representative.

Loose toner • Clean the inside of the machine. (See 
"Cleaning the inside" on page 55.)

• Check the paper type and quality. (See "Print 
media specifications" on page 70.)

• Remove the toner cartridge and then, install a 
new one. (See "Replacing the toner cartridge" 
on page 66.)

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

CONDITION SUGGESTED SOLUTIONS
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Common Windows problems
CONDITION SUGGESTED SOLUTIONS

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the startup group, then restart 
Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool 32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred” messages 
appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in ready mode 
or after printing has been completed, check the 
connection and/or whether an error has 
occurred.

Refer to the Microsoft Windows User’s Guide that came with your 
computer for further information on Windows error messages.

Common Linux problems
CONDITION SUGGESTED SOLUTIONS

The machine does 
not print.

• Check if the printer driver is installed in your 
system. Open the Unified Driver Configurator 
and switch to the Printers tab in Printers
configuration window to look at the list of 
available machines. Make sure that your 
machine is displayed on the list. If not, open 
Add new printer wizard to set up your 
device.

• Check if the machine is started. Open 
Printers configuration and select your 
machine on the printers list. Look at the 
description in the Selected printer pane. If its 
status contains Stopped string, press the 
Start button. After that normal operation of 
the machine should be restored. The 
“stopped” status might be activated when 
some problems in printing occur. 

• Check if your application is not using a special 
print option such as “-oraw”. If “-oraw” is 
specified in the command line parameter, 
then remove it to print properly. For Gimp 
front-end, select “print” -> “Setup printer” and 
edit the command line parameter.

The machine does 
not print whole 
pages, and output is 
printed on half the 
page.

It is a known problem that occurs when a color 
machine is used on version 8.51 or earlier of 
Ghostscript, 64-bit Linux OS, and has been 
reported to bugs.ghostscript.com as Ghostscript 
Bug 688252. The problem is solved in AFPL 
Ghostscript v. 8.52 or above. Download the 
latest version of AFPL Ghostscript from 
http://sourceforge.net/projects/ghostscript/ and 
install it to solve this problem.

I encounter the 
“Cannot open port 
device file” error 
when printing a 
document.

Avoid changing print job parameters (via LPR 
GUI, for example) while a print job is in progress. 
Known versions of CUPS server break the print 
job whenever print options are changed and 
then try to restart the job from the beginning. 
Since Unified Linux Driver locks the port while 
printing, the abrupt termination of the driver 
keeps the port locked and unavailable for 
subsequent print jobs. If this situation occurs, try 
to release the port by selecting Release port in 
Port configuration window.

Refer to the Linux User’s Guide that came with your computer for 
further information on Linux error messages.

Character Voids

A
Character voids are white areas within parts of 
characters that should be solid black:
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of transparencies, some 
character voids are normal. 

• You may be printing on the wrong surface of 
the paper. Remove the paper and turn it 
over. 

• The paper may not meet paper 
specifications. (See "Print media 
specifications" on page 70.)

Horizontal stripes

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C

If horizontally aligned black streaks or smears 
appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and 
reinsert it.

• The toner cartridge may be defective. 
Remove the toner cartridge and install a new 
one. (See "Replacing the toner cartridge" on 
page 66.)

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Curl If the printed paper is curled or paper does not 
feed into the machine:
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray. 
• Change the printer option and try again. Go 

to Printing Preferences, click Paper tab, 
and set type to Thin. (See "Opening printing 
preferences" on page 44.)

CONDITION SUGGESTED SOLUTIONS
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Common Macintosh problems
CONDITION SUGGESTED SOLUTIONS

The machine does 
not print PDF files 
correctly. Some 
parts of graphics, 
text, or illustrations 
are missing.

Printing the PDF file as an image may enable 
the file to print. Turn on Print As Image from the 
Acrobat printing options. 

It will take longer to print when you print a 
PDF file as an image.

The document has 
printed, but the print 
job has not 
disappeared from 
the spooler in Mac 
OS X 10.3.2.

Update your Mac OS to Mac OS X 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the Cover 
page printing.

Mac OS cannot create the font during the Cover 
page printing. The English alphabet and 
numbers are displayed normally on the Cover 
page.

When printing a 
document in 
Macintosh with 
Acrobat Reader 6.0
or higher, colors 
print incorrectly.

Make sure that the resolution setting in your 
machine driver matches the one in Acrobat 
Reader.

Refer to the Macintosh User’s Guide that came with your computer for 
further information on Macintosh error messages.
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10.supplies
This chapter provides information about purchasing supplies and maintenance parts available for your machine.
This chapter includes:
• How to purchase
• Available supplies

• Available maintenance parts
• Replacing the toner cartridge

Available accessories may differ from country to country. Contact your 
sales representatives to obtain the list of available accessories.

HOW TO PURCHASE
To order Samsung-authorized supplies, accessories and, maintenance 
parts, contact your local Samsung dealer or the retailer where you 
purchased your machine. You can also visit www.samsung.com/supplies, 
select your country/region, and obtain information on calling for service.

AVAILABLE SUPPLIES
When supplies reach their lifespan, you can order the following types of 
supplies for your machine:

MODEL NUMBER

• 104 (MLT-D104S): Available in all regions except those listed in 
Region A and B.

• 1042 (MLT-D1042S): Region Aa

a.Region A: Albania, Austria, Belgium, Bosnia, Bulgaria, Croatia, 
Cyprus, Czech Republic, Denmark, Estonia, Finland, France, 
Germany, Greece, Hungary, Italy, Latvia, Lithuania, Macedonia, 
Netherlands, Norway, Poland, Portugal, Romania, Serbia, Slovakia, 
Slovenia, Spain, Sweden, Switzerland, UK. 

• 1043 (MLT-D1043S): Region Bb:

b.Region B: China, Bangladesh, India, Nepal, Ukraine, Vietnam. 

• 104 (MLT-D104X): Not available in all regions.
*Refer to your local Samsung website for availability.

To replace a toner cartridge see "Replacing the toner cartridge" on page 66.
Depending on the options and job mode used, the toner cartridge’s 
lifespan may differ.

You must purchase supplies, including toner cartridges, in the same 
country where you purchased your machine. Otherwise, supplies will 
be incompatible with your machine since the system configuration of 
these vary from country to country.

Samsung does not recommend using non-genuine Samsung toner 
cartridge such as refilled or remanufactured. Samsung cannot 
guarantee non-genuine Samsung toner cartridge's quality. Service or 
repair required as a result of using non-genuine Samsung toner 
cartridges will not be covered under the machine warranty.

AVAILABLE MAINTENANCE PARTS
To avoid print quality and paper feed problems resulting from worn parts 
and to maintain your machine in top working condition, the following parts 
will need to be replaced after printing the specified number of pages or 
when the life span of each item has expired.

PARTS AVERAGE YIELDa

a.Yield is affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.

Transfer roller Approx. 30,000 pages ROLLER-TRANSF
ER

Fuser unit Approx. 30,000 pages FUSER

Pickup roller Approx. 30,000 pages ROLLER-PICK UP

To purchase maintenance parts, contact the source where you bought the 
machine. 
Replacing maintenance parts can be performed only by an authorized 
service provider, dealer, or the retailer where you bought the machine. 
The warranty does not cover the replacement of any maintenance 
parts once they have reached their “Average yield”.

REPLACING THE TONER CARTRIDGE
Click this link to open an animation about replacing a toner cartridge.

When the toner cartridge reaches its estimated cartridge life,
• The Smart Panel program window appears on the computer telling you 

the toner cartridge needs to be replaced.
• The machine stops printing.
At this stage, the toner cartridge needs to be replaced. Check the model 
number for the toner cartridge used in your machine. (See "Available 
supplies" on page 66.)
1. Open the top cover.

When you open the top cover, make sure that the output tray is 
closed.

PART NAME
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2. Pull the toner cartridge out.

3. Take a new toner cartridge out of its package. 
4. Remove the cap protecting the toner cartridge. 

5. Slowly shake the cartridge side to side five or six times to distribute the 
toner evenly inside the cartridge. It will assure maximum copies per 
cartridge. 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

Do not touch the drum located in the toner cartridge or imaging 
unit. Use the handle on the cartridge to avoid touching this area. 

6. Hold the toner cartridge by the handle and slowly insert the cartridge into 
the opening in the machine. 
Tabs on the sides of the cartridge and corresponding grooves within the 
machine will guide the cartridge into the correct position until it locks into 

place completely.

7. Close the top cover. Make sure that the cover is securely closed. 
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11.specifications
This chapter covers the machines primary specifications.
This chapter includes:
• Hardware specifications
• Environmental specifications
• Electrical specifications
• Print media specifications

The specification values are listed below: specifications are subject to change without notice: See www.samsung.com/printer for possible changes in 
information.

HARDWARE SPECIFICATIONS

ITEM DESCRIPTION

Dimension Height 184 mm (7.24 inches)

Depth 224 mm (8.82 inches)

Width 341 mm (13.43 inches)

Weight 4.04 kg (8.9 lbs)

Package weight Paper 0.68 kg (1.5 lbs)

Plastic 0.09 kg (0.19 lbs)

ENVIRONMENTAL SPECIFICATIONS

ITEM DESCRIPTION

Noise Levela

a.Sound Pressure Level, ISO 7779. Configuration tested: machine basic installation, A4 paper, simplex printing.

Ready mode 26 dB(A)

Printing mode 49 dB(A)

Temperature Operation 10 to 32 °C (50 to 90 °F)

Storage (unpacked) 0 to 40 °C (32 to 104 °F)

Humidity Operation  to 80% RH

Storage (unpacked) 0 to 80% RH

ELECTRICAL SPECIFICATIONS
Power requirements are based on the country/region where the device is sold. Do not convert operating voltages. Doing so might damage the device and 
void the product warranty.

ITEM DESCRIPTION

Power ratinga 110 volt models AC 110 - 127 V

220 volt models AC 220 - 240 V
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Power consumption Average operating mode Less than 270 W

Ready mode Less than 45 W

Power save mode Less than 3.9 W 

Power off mode Less than 0.45 W

a.See the rating label on the machine for the correct voltage(V), frequency (hertz) and type of current (A) for your machine.

ITEM DESCRIPTION
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PRINT MEDIA SPECIFICATIONS

TYPE SIZE DIMENSIONS
PRINT MEDIA WEIGHT ba

a.If media weight is over 120 g/m2 (32 lbs), load a paper into the tray one by one.

/CAPACITY

Plain paper Letter 216 x 279 mm (8.50 x 11.00 inches) 60 to 120 g/m2 (16 to 32 lbs bond) 
• 150 sheets of 80 g/m2 (20 lbs 

bond)

60 to 163 g/m2 (16 to 43 lbs 
bond) 
• 1 sheet for manual feeding in 

the tray

Legal 216 x 356 mm (8.50 x 14.00 inches)

US Folio 216 x 330 mm (8.50 x 13.00 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

Oficio 216 x 343 mm (8.50 x 13.50 inches)

JIS B5 182 x 257 mm (7.17 x 10.12 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 0 inches)

A5 148 x 210 mm (5.83 x 8.27 inches)

Envelope Envelope Monarch 98 x 191 mm (3.87 x 7.50 inches) 75 to 90 g/m2 (20 to 24 lbs bond)
• 1 sheet for manual feeding in the trayEnvelope No. 10 105 x 241 mm (4.12 x 9.50 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.38 x 9.02 inches)

Thick paper Refer to the Plain 
paper section 

Refer to the Plain paper section 90 g/m2 (24 lbs bond)
• 140 sheets 

90 to 163 g/m2 (24 to 43 lbs 
bond)
• 1 sheet for manual feeding in 

the tray

Thin paper Refer to the Plain 
paper section 

Refer to the Plain paper section 60 to 70 g/m2 (16 to 19 lbs bond)
• 1 sheet for manual feeding in the tray

Transparency Letter, A4 Refer to the Plain paper section 138 to 146 g/m2 (37 to 39 lbs bond)
• 1 sheet for manual feeding in the tray

Labelsc

c. Smoothness: 100 to 250 (sheffield).

Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5

Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lbs bond)
• 1 sheet for manual feeding in the tray

Card stock Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5

Refer to the Plain paper section 105 to 163 g/m2 (28 to 43 lbs bond)
• 1 sheet for manual feeding in the tray

Minimum size (custom) 76 x 183 mm (3.00 x 7.20 inches) 60 to 163 g/m2 (16 to 43 lbs bond) 
Maximum size (custom) 216 x 356 mm (8.50 x 14.02 inches)

b.Maximum capacity may differ depending on media weight, thickness and environmental conditions. 

TRAY MANUAL FEEDING IN THE 
TRAY
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contact samsung worldwide
If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE

ARGENTINE 0800-333-3733 www.samsung.com

ARMENIA 0-800-05-555

AUSTRALIA 1300 362 603 www.samsung.com

AUSTRIA 0810-SAMSUNG (7267864, 
€ 0.07/min)

www.samsung.com

AZERBAIJAN 088-55-55-555

BAHRAIN 8000-4726

BELARUS 810-800-500-55-500 www.samsung.ua
www.samsung.com/ua_ru

BELGIUM 02-201-24-18 www.samsung.com/be 
(Dutch)
www.samsung.com/be_fr 
(French)

BRAZIL 0800-124-421
4004-0000

www.samsung.com

CANADA 1-800-SAMSUNG 
(726-7864)

www.samsung.com

CHILE 800-SAMSUNG (726-7864) www.samsung.com

CHINA 400-810-5858
010-6475 1880

www.samsung.com

COLOMBIA 01-8000112112 www.samsung.com

COSTA RICA 0-800-507-7267 www.samsung.com

CZECH 
REPUBLIC

800-SAMSUNG 
(800-726786)

www.samsung.com

Samsung Zrt., eská organiza ní složka, Oasis Florenc, 
Sokolovská394/17, 180 00, Praha 8

DENMARK 70 70 19 70 www.samsung.com

ECUADOR 1-800-10-7267 www.samsung.com

EGYPT 0800-726786

EIRE 0818 717100 www.samsung.com

EL SALVADOR 800-6225 www.samsung.com

ESTONIA 800-7267 www.samsung.com

KAZAKHSTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

KYRGYZSTAN 00-800-500-55-500

FINLAND 030-6227 515 www.samsung.com

FRANCE 01 48 63 00 00 www.samsung.com

GERMANY 01805 - SAMSUNG 
(726-7864 € 0,14/min)

www.samsung.com

GEORGIA 8-800-555-555

GUATEMALA 1-800-299-0013 www.samsung.com

HONDURAS 800-7919267 www.samsung.com

HONG KONG (852) 3698-4698 www.samsung.com/hk
www.samsung.com/hk_en/

HUNGARY 06-80-SAMSUNG 
(726-7864)

www.samsung.com

INDIA 3030 8282
1800 110011
1800 3000 8282 
1800 266 8282

www.samsung.com

INDONESIA 0800-112-8888
021-5699-7777

www.samsung.com

ITALIA 800-SAMSUNG (726-7864) www.samsung.com

JAMAICA 1-800-234-7267 www.samsung.com

JAPAN 0120-327-527 www.samsung.com

JORDAN 800-22273

KSA 9200-21230 www.samsung.com

BAHRAIN 8000-4726

LATVIA 8000-7267 www.samsung.com

LITHUANIA 8-800-77777 www.samsung.com

LUXEMBURG 261 03 710 www.samsung.com

MALAYSIA 1800-88-9999 www.samsung.com

MEXICO 01-800-SAMSUNG 
(726-7864)

www.samsung.com

MOLDOVA 00-800-500-55-500 www.samsung.ua
www.samsung.com/ua_ru

NETHERLANDS 0900-SAMSUNG 
(0900-7267864) (€ 
0,10/min)

www.samsung.com

NEW ZEALAND  0800 SAMSUNG (0800 726 
786)

www.samsung.com

NICARAGUA 00-1800-5077267 www.samsung.com

NORWAY 815-56 480 www.samsung.com

PANAMA 800-7267 www.samsung.com

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE
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PHILIPPINES 1800-10-SAMSUNG 
(726-7864)
1-800-3-SAMSUNG 
(726-7864)
1-800-8-SAMSUNG 
(726-7864)
02-5805777

www.samsung.com

POLAND 0 801 1SAMSUNG 
(172678)
022-607-93-33

www.samsung.com

PORTUGAL 80820-SAMSUNG 
(726-7864)

www.samsung.com

PUERTO RICO 1-800-682-3180 www.samsung.com

QATAR 800-2255

REP. DOMINICA 1-800-751-2676 www.samsung.com

RUSSIA 8-800-555-55-55 www.samsung.ru

SINGAPORE 1800-SAMSUNG 
(726-7864)

www.samsung.com

SLOVAKIA 0800-SAMSUNG 
(726-7864)

www.samsung.com

SOUTH AFRICA 0860 SAMSUNG 
(726-7864)

www.samsung.com

SPAIN 902-1-SAMSUNG(902 172 
678)

www.samsung.com

SWEDEN 0771 726 7864 
(SAMSUNG)

www.samsung.com

SWITZERLAND 0848-SAMSUNG (7267864, 
CHF 0.08/min)

www.samsung.com

SYRIA 1825-22-73

TADJIKISTAN 8-10-800-500-55-500

TAIWAN 0800-329-999 www.samsung.com

THAILAND 1800-29-3232
02-689-3232

www.samsung.com

TRINIDAD & 
TOBAGO

1-800-SAMSUNG 
(726-7864)

www.samsung.com

TURKEY 444 77 11 www.samsung.com

U.A.E 800-SAMSUNG (726-7864) www.samsung.com

U.K 0845 SAMSUNG 
(726-7864)

www.samsung.com

U.S.A 1-800-SAMSUNG 
(726-7864)

www.samsung.com

UKRAINE 8-800-502-000 www.samsung.ua
www.samsung.com/ua_ru

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

VENEZUELA 0-800-100-5303 www.samsung.com

VIETNAM 1 800 588 889 www.samsung.com

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE
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glossary
The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user’s guide.

802.11
802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards 
Committee (IEEE 802). 

802.11b/g/n
802.11b/g/n can share same hardware and use the 2.4 GHz band. 
802.11b supports bandwidth up to 11 Mbps, 802.11n supports 
bandwidth up to 150 Mbps. 802.11b/g/n devices may occasionally suffer 
interference from microwave ovens, cordless telephones, and Bluetooth 
devices.

Access point
Access Point or Wireless Access Point (AP or WAP) is a device that 
connects wireless communication devices together on wireless local 
area networks (WLAN), and acts as a central transmitter and receiver of 
WLAN radio signals. 

ADF
An Automatic Document Feeder (ADF) is a scanning unit that will 
automatically feed an original sheet of paper so that the machine can 
scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) 
and is now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 

client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the machine. 

Coverage
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a de facto standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a scanning unit that 
will automatically feed and turn over an original sheet of paper so that 
the machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.
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DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing data, 
received fax data.

DLNA
The Digital Living Network Alliance (DLNA) is a standard that allows 
devices on a home network to share information with each other across 
the network.

DMPr
The Digital Media Printer (DMPr) is a device that allows printing in DLNA 
home network. The DMPr prints a page by combining images with an 
Extensible HyperText Markup Language (XHTML) template. 

DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically turn over a sheet of paper so that 
the machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex Unit can print on both sides of paper during one 
print cycle.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax machines or fax modems. It automatically detects and 
corrects errors in the fax transmission process that are sometimes 
caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results as 
another.
An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that fuses the toner onto the print media. It 
consists of a heat roller and a pressure roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure that 
the toner stays on the paper permanently, which is why paper is warm 
when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.
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HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 

Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization,
allocation of the radio spectrum, and organizing interconnection 
arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 
compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over 
TCP/IP.

LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a machine.

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 
00-00-0c-34-11-4e). This address is usually hard-coded into a Network 
Interface Card (NIC) by its manufacturer, and used as an aid for routers 
trying to locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax machines 
to transfer the image recommended by ITU-T T.4. MH is a 
codebook-based run-length encoding scheme optimized to efficiently 
compress white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 
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MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.

MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.

NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or rust colored and has a cylinder shape. 
An imaging unit containing a drum slowly wears the drum surface by its 
usage in the printer, and it should be replaced appropriately since it gets 
worn from contact with the cartridge development brush, cleaning 
mechanism, and paper.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, dot matrix printer, and laser 
printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used in a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

RADIUS
Remote Authentication Dial In User Service (RADIUS) is a protocol for 
remote user authentication and accounting. RADIUS enables 
centralized management of authentication data such as usernames and 
passwords using an AAA (authentication, authorization, and accounting) 
concept to manage network access.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
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between nodes on a network. It also provides an authenticated 
Inter-process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, 
text-based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.

SSID
Service Set Identifier (SSID) is a name of a wireless local area network 
(WLAN). All wireless devices in a WLAN use the same SSID in order to 
communicate with each other. The SSIDs are case-sensitive and have a 
maximum length of 32 characters.

Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle or container used in a machine like a printer which 
contains toner. Toner is a powder used in laser printers and 
photocopiers, which forms the text and images on the printed paper. 
Toner can be fused by by a combination of heat/pressure from the fuser, 
causing it to bind to the fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a 
TWAIN-compliant scanner with a TWAIN-compliant program, a scan can 
be initiated from within the program. It is an image capture API for 
Microsoft Windows and Apple Macintosh operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WEP
Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 
802.11 to provide the same level of security as that of a wired LAN. WEP 
provides security by encrypting data over radio so that it is protected as 
it is transmitted from one end point to another.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.

WPA
Wi-Fi Protected Access (WPA) is a class of systems to secure wireless 
(Wi-Fi) computer networks, which was created to improve upon the 
security features of WEP.

WPA-PSK
WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small 
business or home users. A shared key, or password, is configured in the 
wireless access point (WAP) and any wireless laptop or desktop 
devices. WPA-PSK generates a unique key for each session between a 
wireless client and the associated WAP for more advanced security.

WPS
The Wi-Fi Protected Setup (WPS) is a standard for establishing a 
wireless home network. If your wireless access point supports WPS, you 
can configure the wireless network connection easily without a 
computer.
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XPS
XML Paper Specification (XPS) is a specification for a Page Description 
Language (PDL) and a new document format, which has benefits for 
portable document and electronic document, developed by Microsoft. It 
is an XML-based specification, based on a new print path and a 
vector-based device-independent document format.


